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Important Information

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND
CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE
CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD
OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE)
OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER
LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE
SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE
BOUND BY THE SAME.

ANY SOFTWARE ITEM IDENTIFIED AS THIRD PARTY LIBRARY IS AVAILABLE UNDER
SEPARATE SOFTWARE LICENSE TERMS AND IS NOT PART OF A TIBCO PRODUCT. AS SUCH,
THESE SOFTWARE ITEMS ARE NOT COVERED BY THE TERMS OF YOUR AGREEMENT WITH
TIBCO, INCLUDING ANY TERMS CONCERNING SUPPORT, MAINTENANCE, WARRANTIES,
AND INDEMNITIES. DOWNLOAD AND USE OF THESE ITEMS IS SOLELY AT YOUR OWN
DISCRETION AND SUBJECT TO THE LICENSE TERMS APPLICABLE TO THEM. BY PROCEEDING
TO DOWNLOAD, INSTALL OR USE ANY OF THESE ITEMS, YOU ACKNOWLEDGE THE
FOREGOING DISTINCTIONS BETWEEN THESE ITEMS AND TIBCO PRODUCTS.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix, ActiveMatrix BusinessWorks, ActiveSpaces,
TIBCO Administrator, TIBCO BusinessEvents, TIBCO Designer, Enterprise Message Service, TERR,
TIBCO FTL, Hawk, TIBCO LiveView, TIBCO Runtime Agent, Rendezvous, Statistica, and StreamBase
are either registered trademarks or trademarks of TIBCO Software Inc. in the United States and/or other
countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. Please see the readme.txt file for
the availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO
SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S)
AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.
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This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to
TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 2004-2019. TIBCO Software Inc. All Rights Reserved.
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TIBCO Documentation and Support Services

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly
in HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current than any other
documentation included with the product. To access the latest documentation, visit https://
docs.tibco.com.

Product-Specific Documentation

Documentation for TIBCO BusinessEvents® Enterprise Edition is available on the TIBCO
BusinessEvents® Enterprise Edition Product Documentation page.

To directly access documentation for this product, double-click the following file:

TIBCO_HOME/release_notes/TIB_businessevents-enterprise_5.6.1_docinfo.html where
TIBCO_HOME is the top-level directory in which TIBCO products are installed. On Windows, the
default TIBCO_HOME is C:\tibco. On UNIX systems, the default TIBCO_HOME is /opt/tibco.

The following documents for this product can be found in the TIBCO Documentation site:

● TIBCO BusinessEvents® Release Notes

● TIBCO BusinessEvents® Installation

● TIBCO BusinessEvents® Getting Started

● TIBCO BusinessEvents® Architect's Guide

● TIBCO BusinessEvents® Administration

● TIBCO BusinessEvents® Developer's Guide

● TIBCO BusinessEvents® Cloud Deployment Guide

● TIBCO BusinessEvents® Data Modeling Developer's Guide

● TIBCO BusinessEvents® Event Stream Processing Pattern Matcher Developer's Guide

● TIBCO BusinessEvents® Event Stream Processing Query Developer's Guide

● TIBCO BusinessEvents® Configuration Guide

● TIBCO BusinessEvents® WebStudio User's Guide

● TIBCO BusinessEvents® Decision Manager User's Guide

● Online References:

— TIBCO BusinessEvents® Java API Reference

— TIBCO BusinessEvents® Functions Reference

How to Contact TIBCO Support

You can contact TIBCO Support in the following ways:

● For an overview of TIBCO Support, visit http://www.tibco.com/services/support.

● For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the TIBCO Support portal at https://support.tibco.com.
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● For creating a Support case, you must have a valid maintenance or support contract with TIBCO.
You also need a user name and password to log in to https://support.tibco.com. If you do not have a
user name, you can request one by clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter
experts to share and access their collective experience. TIBCO Community offers access to Q&A forums,
product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and
tools that extend and enable customers to gain full value from TIBCO products. In addition, users can
submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to 
https://community.tibco.com.
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Installation

The TIBCO Universal Installer is used to install and uninstall this TIBCO BusinessEvents software.

TIBCO BusinessEvents Components and Add-on Products
This section lists the product components and add-on products.

TIBCO BusinessEvents® Enterprise Edition Components
TIBCO BusinessEvents Enterprise Edition comprises of several components using which the
BusinessEvents performs different functions.

● TIBCO BusinessEvents Studio - Eclipse-based component for designing TIBCO BusinessEvents
projects.

● TIBCO BusinessEvents DataGrid - Used for cache functionality. It can be updated separately. This
component requires TIBCO ActiveSpaces to be installed in same TIBCO_HOME as TIBCO
BusinessEvents.

● Enterprise Administrator Agent - A back-end server process that provides management and
monitoring functionality for a BusinessEvents application and cluster. It communicates with the
TIBCO Enterprise Administrator Server for UI interactions.

● Eclipse Platform - A provided Eclipse platform. If you do not use the provided Eclipse installation,
you must have a preexisting Eclipse installation, at the supported release level. See Existing Eclipse
(or TIBCO Business Studio) Installation for more information.

● Examples - Few example BusinessEvents projects to help you learn TIBCO BusinessEvents faster.

● Rules Management Server (RMS) - A lightweight server component for managing the repository of
projects. It also includes the client component, WebStudio, which is a web-based user interface that
allows business users to create and manage business rules in a web browser.

● Database Concepts - Database concepts are TIBCO BusinessEvents concepts that you create by
mapping tables or views from a database to TIBCO BusinessEvents concepts.

● State Modeler - A component to create state models on the lifecycle of concepts based on UML-
standard definitions.

● Decision Manager - The component provides TIBCO BusinessEvents Decision Manager Desktop
Application and Rules Management Server features that help you to author, test and submit rules
for approval and deployment to a TIBCO BusinessEvents application.

● Live DataMart Plugin - The component provides the capability to use TIBCO LiveView Web to
display the changes to the BusinessEvents project in various visualizations.

● Query - The component enables you to query the event streams and data caches.

● Pattern Matcher Framework - The component enables pattern matching functionality in the event
streams.

● Oracle Elliptic Curve Cryptography Library - Select the component if you want to use the Elliptic
Curve Cryptography (ECC) ciphers with SSL/TLS configurations. Without the ECC library, the
SSL/TLS functionality is still available, but without the ECC ciphers.

Add-on Products
When you install TIBCO BusinessEvents® Enterprise Edition, you can also install any add-on products
you have purchased.

The following TIBCO BusinessEvents add-ons are available in this release:

● TIBCO BusinessEvents Process Orchestration
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● TIBCO BusinessEvents Views

Install all add-ons that are at the same version as TIBCO BusinessEvents. Do not install add-ons before
you have installed TIBCO BusinessEvents. (You can, however, install TIBCO BusinessEvents and add-
ons at the same time, as explained in the installation instructions.)

Installation Overview

Add-ons must be at the same version as TIBCO BusinessEvents in order to work correctly. When you
upgrade TIBCO BusinessEvents, you must also upgrade the add-on products in use to the same
version. Similarly, you cannot install a later version of an add-on onto an earlier version of TIBCO
BusinessEvents.

Deploying with TIBCO Administrator on the Same Machine

If TIBCO Administrator is used to deploy TIBCO BusinessEvents applications and both are installed on
the same machine, then install TIBCO Runtime Agent and TIBCO Administrator before you install
TIBCO BusinessEvents. TIBCO Administrator does not find TIBCO BusinessEvents, if TIBCO
BusinessEvents is installed before TIBCO Administrator.

This requirement does not apply on machines where TIBCO BusinessEvents will be used for design-
time activities only.

Using Oracle Coherence as Alternative Cache Provider
Only TIBCO BusinessEvents DataGrid is provided with TIBCO BusinessEvents. Alternatively, you can
use a supported version of Oracle Coherence, for which you must have a license that is appropriate for
your usage.

Required and Optional Products and Supported Platforms
For details about supported platforms, related TIBCO software, and third-party products, see the
product readme file available at https://docs.tibco.com.

Installation History Log Files
Installation and uninstallation history is kept in log files in the .TIBCO directory within the installer’s
user (or home) directory.

The folder names use this format:
install_year-month-day.time
maintenance_year-month-day.time

The installation log files record environment details such as the user that invoked the installer,
hostname, operating system details, and so on.

TIBCO Home and Default Installation Directory

The installer prompts you to specify the TIBCO home (TIBCO_HOME) where you want to install TIBCO
BusinessEvents. Each TIBCO home is a separate environment. You can install the same software into
different environments safely, for example, for test, QA, and staging purposes. You can install multiple
TIBCO products into the same environment or into different ones. See Using Multiple TIBCO Homes.

A TIBCO home has a name and a directory on disk. The directory is the root directory for all TIBCO
products you want to install into this TIBCO home.

When installing multiple TIBCO products into a single TIBCO Home, ensure that all the products are
compatible.
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Microsoft Windows

The default installation location is the TIBCO_HOME where all TIBCO products are installed. Typically,
TIBCO_HOME is c:\tibco.

The Start menu path to the executable files includes the environment as follows:

Start > TIBCO > TIBCO_HOME > TIBCO BusinessEvents <version_number>

The name is also appended to the name of Windows services created by the installer.

UNIX

The default installation directory depends on who performs the installation:

● For root users, the default installation directory is /opt/tibco.

● For non-root users, the default installation directory is /<myhome>/tibco, where <myhome> is the
home directory of the user.

Using Multiple TIBCO Homes
Install multiple products, or multiple versions of the same product, in the same machine in separate
TIBCO_HOME, so that all of them can function smoothly.

It is possible that certain versions of TIBCO software products installed on your computers may not
work well together. You may also want to install multiple versions of the same product on the same
machine, for example if you are testing the current release while using the prior release in production.
To avoid any issues, one solution is to install each product version in its own TIBCO_HOME, under a
common parent directory, for example called tibco.

In the following example, be_40, be_50, bw_59 and administrator_57 are all separate TIBCO homes:
tibco/
      be_40/
            be
      be_50/
            be
      bw_59/
            bw
      administrator_57/
            administrator

Using an Existing Eclipse (or TIBCO Business Studio™) Installation
Using the bundled Eclipse software is recommended. However, you can optionally use an existing
Eclipse installation. You can, for example, use the Eclipse installation provided with TIBCO Business
Studio business modeling software. This option is not available with partial installers (commonly used
for service pack releases).

Limiting Access to TIBCO BusinessEvents Installations

Here is another case for using an existing Eclipse installation. In some enterprises, users are given
limited access to software, such as TIBCO BusinessEvents. All users, however, require full rights to the
Eclipse installation because certain files are written during normal use of BusinessEvents Studio. In this
case you must install Eclipse separately, in areas where users have permission to write.

See Existing Eclipse (or TIBCO Business Studio) Installation.

LGPL GTK Plugin for Eclipse
You can now install an LPGL GTK plugin for Eclipse.
You can either manually download the LGPL plugin or use the TIBCO Universal Installer download to
it for installation.
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● This procedure is applicable to the Linux, HPUX, AIX, and Solaris platforms. Installation for
Windows and Mac remain unchanged.

● If you have performed installation before, using same installers with on-the-fly download option,
the LGPL plug-ins are present in assemblies folder. Thus, in such case, the installer do not prompts
for the LGPL plug-ins download.

Procedure

1. During installation, select the option to use the TIBCO Universal Installer to download the LGPL
plugin and install the plugin from the public TIBCO download site.

● GUI Mode - Select the Download Gnome Binding assembly from TIBCO option in the LGPL
Assembly Window of the installer for Linux.

LGPL Assembly Download Window for Linux

● Console Mode - When the installer prompts for the action to perform for LGPL assembly
download, enter 1 to select the option Download Gnome Binding assembly from the
public TIBCO download site.

● Silent Mode - Specify the following properties in the silent file:
<entry key="LGPLAssemblyLicenseAccepted">true</entry>
<entry key="LGPLAssemblyDownload">true</entry>
<entry key="LGPLAssemblyPath"></entry>

The downloaded plugins are placed at the following locations:

● TIBCO_HOME/eclipse-platform/eclipse/plugins/
● <installer_path>/assemblies/

2. Alternatively, you can download the LGPL plugin separately and then provide the downloaded
location to the installer. Installer then uses that assembly for installation.
a) Download the platform-specific LGPL plugin from http://public.tibco.com/pub/tibco_oss/
eclipse_lgpl/.
For example, for Linux download the
product_tibco_be_eclipse_lgpl_4.4.1.001_linux_x86_64.zip archive.
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b) Provide the path of the downloaded plugin to the installer.

● GUI Mode - Select the Provide the location for the assembly previous downloaded from
TIBCO option in the LGPL Assembly Download window of the installer. Click Browse and
select the location of the downloaded LGPL plugin for the Gnome Binding Assembly Path
field.

● Console Mode - When installer prompts for the action to perform for LGPL assembly
download, enter 2 to select the option Specify the location of a previously
downloaded Gnome Binding assembly. Now enter the file path to the downloaded LGPL
plugin in command line.

● Silent Mode - Specify the following properties in the silent file:
<entry key="LGPLAssemblyLicenseAccepted">true</entry>
<entry key="LGPLAssemblyDownload">false</entry>
<entry key="LGPLAssemblyPath">filePathToDownloadedPlugin</entry>

Installer places the plugins at TIBCO_HOME/eclipse-platform/eclipse/plugins/.

Upgrading TIBCO BusinessEvents

Read Migrating Projects from Earlier Versions before upgrading.

Standard Upgrade Procedures
Software from TIBCO uses three numbers to indicate whether the release is major, minor or a patch. For
example, 5.0.0 indicates a major release, 5.1.0 indicates a minor release and 5.1.1 indicates a service pack
release.

The installer for a service pack release performs an automatic upgrade. For example, the installer would
automatically upgrade TIBCO BusinessEvents 5.1.0 to 5.1.1 by overwriting the contents of the 5.1
directory.

Installing Over the Same Version
Note that if you are reinstalling over the same version, if any files are currently locked (that is, in use),
the installer marks the file for deletion in the install location. After installation if the installer prompts
you to reboot your system, you must reboot before using the software.
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Installation Requirements

Before you run the installer, ensure that you meet all the hardware and software requirements and you
have appropriate privileges to run the installer.

Check the TIBCO Product Support website at https://support.tibco.com for product information that
was not available at release time. Entry to this site requires a username and password. If you do not
have a username, you can request one. You must have a valid maintenance or support contract to use
this site.

If TIBCO Administrator is used to deploy TIBCO BusinessEvents applications and both are installed on
the same machine, then install TIBCO Runtime Agent and TIBCO Administrator before you install
TIBCO BusinessEvents. TIBCO Administrator do not find TIBCO BusinessEvents, if TIBCO
BusinessEvents is installed before TIBCO Administrator.

Installer Account
Ensure that you have the appropriate privileges, depending on the platform on which you are
installing.

Platform Account Privileges

Microsoft
Windows

You must have administrator privileges for the machine on which the software
is installed. If you do not have administrator privileges, the installer exits. You
must then log out of the system and log in as a user with the required
privileges, or request your system administrator to assign the privileges to your
account.

If you intend to install the product from a network drive, you must ensure that
the account used for installation has permission to access the network drive.

Linux The software can be installed by a regular (non-root) user and super-user (root).
Different users can install the same product at different locations.

The user performing the installation must have Read Write Execute permissions
on all files and directories, after the file is unpacked. The file structure after
unpacking must be identical to the structure that was packed.

Installation of TIBCO BusinessEvents add-on products must be performed by
the same user who installed TIBCO BusinessEvents. Dependency checking will
not work correctly unless the same user installs all dependent products.

A windowing environment such as CDE (that is, X11 Windows) is required to
run the installer in GUI mode.

Hardware and Software Requirements
The product has certain hardware and software requirement for installation.

For information about the hardware and software requirements, as well as supported platforms, related
TIBCO software, and third-party products, see the readme file that is provided with the product.

TIBCO ActiveSpaces® Enterprise Edition

TIBCO BusinessEvents software requires TIBCO ActiveSpaces® Enterprise Edition to be installed in the
same TIBCO_HOME as TIBCO BusinessEvents. Refer the readme file for the minimum product version
requirements. For more information on how to install TIBCO ActiveSpaces Enterprise Edition, refer to
the TIBCO ActiveSpaces documentation.
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If your application do not use or need TIBCO DataGrid, select the Customize Installation check box
and clear the TIBCO BusinessEvents Datagrid option in the Component Selection page during
installation. In such case only the In memory functionality would be available in BusinessEvents.

TIBCO® Enterprise Administrator

TIBCO Enterprise Administrator needs to be installed, if you want to use TIBCO Enterprise
Administrator console for monitoring and managing TIBCO BusinessEvents application.
BusinessEvents uses TIBCO BusinessEvents Enterprise Administrator Agent for communicating with
TIBCO Enterprise Administrator. BusinessEvents Enterprise Administrator Agent is part of the TIBCO
BusinessEvents Standard installation options and is installed at BE_HOME/teagent.
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Installing the Software

The TIBCO Universal Installer can be used to install in GUI mode, console mode, or silent mode.

You can install multiple products at one time by extracting the product archive files to the same
temporary directory. For example, you can install TIBCO BusinessEvents and one or more add-ons
together. Or if you have already installed TIBCO BusinessEvents, you can install multiple add-ons
together.

This technique works in the GUI and Console modes but not in Silent mode. In Silent mode, the silent
installation file is overwritten with the last product that you extract, and installs only the last extracted
product.

Installing in GUI Mode
When you run the installer in GUI mode, it prompts you for information about the installation
environment, and allows other customization.

Procedure

1. Prepare to install as follows:
a) Log in to the system on which you want to install TIBCO BusinessEvents.
b) Extract the TIBCO BusinessEvents product archive file to a temporary directory then navigate to

that directory. You can also extract the product archive files for all TIBCO BusinessEvents add-on
products that you are installing to the same temporary directory. See the Tip section above,

2. Run the TIBCO Universal Installer executable (TIBCOUniversalInstaller*).

3. Review the information in the Welcome dialog. If you are installing multiple add-ons, they are
listed in this dialog. Click Next.

4. The License Agreement dialog displays. Review the terms of the license agreement and, if you agree
to them, click I accept the terms of the license agreement. Then click Next to continue with the
installation. If you are also installing add-on products, you must accept each license separately.

(If you do not agree to the terms of the license agreement, click Cancel to exit from the installation
process.)

5. Select or create a TIBCO home. For more details and guidelines see TIBCO Home and Default
Installation Directory. Do one of the following:

● Select Use an Existing TIBCO_HOME and select a home from the list.

For a service pack, select the TIBCO home used by the prior release.

● Select Create a new TIBCO_HOME and specify a new TIBCO installation directory. Enter the
directory path or click Browse to select a directory.

Click Next.

The selected directory name is automatically taken as the environment name for the
new TIBCO Installation.

6. For full installers only, you can customize the installation as follows.

(If you don’t want to customize the installation just click Next without checking the Customize
Installation checkbox and go to step 5.)
a) Check the Customize Installation check box.
b) Optionally select only the components you want to install. See TIBCO BusinessEvents

Components and Add-on Products for guidelines.
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If your application do not use or need TIBCO DataGrid, clear the TIBCO
BusinessEvents Datagrid option. In such case only the In memory functionality would
be available in BusinessEvents.

c) Click Next.
d) A dialog appears where you can specify the location of a different Eclipse installation from the

version provided with TIBCO BusinessEvents. Do one of the following.

● Do not check the Use my own Eclipse installation check box. Just click Next to accept the
provided Eclipse installation. (This is the recommended approach).

● Check the Use my own Eclipse installation check box. Specify the location of your Eclipse
installation in the Eclipse Installation Location field, and click Next. Also see Existing Eclipse
(or TIBCO Business Studio) Installation for additional configuration required to use your own
installation.

7. The installer performs some basic checks and if it finds any problems with the Eclipse configuration
that you specified, it displays messages. If you are installing TIBCO BusinessEvents before your
own copy of Eclipse, you can ignore the messages and continue the installation.

8. (Linux, Windows, macOS, and Solaris platforms only) If you are using the default installation
profile or have selected Oracle Elliptic Curve Cryptography Library component in the customized
installation, the Oracle Elliptic Curve Cryptography (ECC) ciphers are installed.
a) In the Oracle Elliptic Curve Cryptography Library LGPL License Agreement screen, review the

terms of the license agreement and, if you agree to them, click I accept the terms of the license
agreement. Then click Next to continue with the installation.

If you do not agree to the terms of the license agreement, click Cancel to exit from the
installation process.

If you have performed installation before, using same installers with on-the-fly
download option, the Oracle ECC ciphers are present in the assemblies folder. Thus, in
such case, the installer do not prompts for the Oracle ECC cipher assembly download.

b) In the LGPL Assembly Download Window, select either of the following option and click Next:

● Download Oracle Elliptic Curve Cryptography Library assembly from TIBCO - To
download the Oracle ECC assembly from TIBCO website.

● Provide the location for the assembly previously downloaded from TIBCO - To provide the
path of the downloaded TIBCO provided Oracle ECC assembly
(product_tibco_sunec_<version>_<platform>). You can download the platform-specific
Oracle ECC LGPL assembly from http://public.tibco.com/pub/tibco_oss/sunec/.

9. The installer configures your installation choices, then the Pre-Install Summary dialog displays.
Review the information in the dialog and make sure that it is correct.

If you want to change any of your choices, click Back to step back through the dialogs to the
appropriate point. You can then restart the installation process from that point.

If you are satisfied with your choices, click Install.

The installer now performs the necessary installation tasks.

10. You may be prompted to replace files already on disk that are newer than the installation files.

● In the case of a fresh installation of the add-on over a prior fresh installation of a full installer
version of the add-on or of TIBCO BusinessEvents, such messages are harmless: overwrite all
existing files.

● In the case of files you have changed: if you want to save settings in any existing files, first save
a backup of the files to a different name, and then replace the original files with the newly
installed files. After installation configure the newly installed files using information from the
prior version’s file backups, as needed.
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11. When installation has completed, the Post Install Summary dialog displays. Click Finish to exit
from the installer. There is a slight delay while the installer deletes temporary files.

Installing in Console Mode
In console mode, the TIBCO Universal Installer is run from a command line.

Procedure

1. Open the physical media or download the software package from https://edelivery.tibco.com.

For downloading you will need your username and password. If you did not receive a username
and password, contact TIBCO Technical Support.

2. Extract the contents of the package to a temporary directory.

3. Using a command line, navigate to the temporary directory to which you extracted the installation
package.

4. Run the installer using this command line:

● Microsoft Windows: TIBCOUniversalInstaller.cmd -console

● Linux: ./TIBCOUniversalInstaller-platform_acronym.bin -console

5. Respond to the messages on the command line.

You may want to refer to Installing in GUI Mode for information about responding to the messages.

6. When the installation completes, press Enter to exit the installer.

Installing in Silent Mode
In the silent mode, you can run the installer without user input by pointing the installer to an existing
response file, which contains installation parameters.

A default response file is included with the product. Edit the file in a text editor and provide all non-
default values as needed before launching the silent installation. For example, ensure that the
installationRoot and createNewEnvironment attributes are set correctly. The default response file
has the name:

TIBCOUniversalInstaller.silent

The best practice is to make a copy of the default response file, then edit that file and use it for the
installation.

If you invoke the Universal Installer with only the -silent argument, the installer reads the input from
default response file.

If you make a copy of the default response file, and rename it, you must provide the name of the
response file when invoking the Universal Installer. This done by passing the following arguments on
the command line:

-silent -V responseFile="filename.silent"

where, filename is the name you gave the response file.

(Linux, Windows, macOS, and Solaris Platforms Only) Oracle ECC Library

If you want to use the ECC ciphers with SSL/TLS configurations, update the following entries in the
response file:

● Set the entry to install Oracle ECC cipher with TIBCO BusinessEvents to true.
<entry key="feature_Oracle Elliptic Curve Cryptography Library_businessevents-
enterprise">true</entry>
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● Set the entry to accept the Oracle ECC LGPL.
<entry key="LGPLAssemblyLicenseAccepted">true</entry>

● Set entries for either of the following options:

— To download the Oracle ECC assembly from TIBCO website.
<entry key="LGPLAssemblyDownload">true</entry>
<entry key="LGPLAssemblyPath"></entry>

— To provide the path of the downloaded TIBCO provided Oracle ECC assembly
(product_tibco_sunec_<version>_<platform>). You can download the platform-specific
Oracle ECC LGPL assembly from http://public.tibco.com/pub/tibco_oss/sunec/ .
<entry key="LGPLAssemblyDownload">false</entry>
<entry key="LGPLAssemblyPath">filePathToDownloadedPlugin</entry>

Procedure

1. Open the physical media or download the software package from https://edelivery.tibco.com.

For downloading you will need your username and password. If you did not receive a username
and password, contact TIBCO Technical Support.

2. Extract the contents of the package to a temporary directory.

3. Navigate to the temporary directory to which you extracted the installation package.

4. Make a copy of the default response file, open the copy with a text editor, then update the
parameters as needed.

The response file contains comments that describe each of the parameters. You can save the file using
any desired name.

5. Enter the following command to start the installation (these assume you have copied the response
file and saved it as MyResponseFile.silent):

● Microsoft Windows: TIBCOUniversalInstaller.cmd -silent -
VresponseFile="MyResponseFile.silent"

● Linux: TIBCOUniversalInstaller-platform_acronym.bin -silent -
VresponseFile="MyResponseFile.silent"

If you copy the response file to another directory, not the temporary directory
containing the installer, you need to provide the absolute path of the response file.

A line like similar to the following is written to the installer log file when installation
completes:

The installation has completed. Please check the log file for additional

information.
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Verifying the Installation

You can verify TIBCO BusinessEvents and TIBCO BusinessEvents add-on product installations after the
installation is complete.

Verifying TIBCO BusinessEvents Installation

To verify if the installation is successful, first check the file
tibco_universal_installer.userid_install.log, which is located in the .TIBCO directory of the
user performing the installation:

Errors in this file, or the existence of error files under this folder, indicates installation problems. Error
files have the following format:
antTask_ERROR_log_post-install_mm-dd-yyy.n.log

If the log files do not indicate any errors, then open a simple example project in TIBCO BusinessEvents
Studio, and also run the example at the command line. The example readme files explain how to run
the examples at the command line, from the installed location. Check for errors on the command line or
user interface. Absence of errors, and a normal engine startup indicate successful installation.

Verifying Add-On Product Installations

To verify that add-ons are installed, look for the list of add-ons in the folder TIBCO_HOME/
_installInfo. Every successfully installed add-on has a corresponding XML file under this folder.

You can also check the install log file to confirm which add-ons are installed.
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Uninstalling TIBCO BusinessEvents

 In the case of a service pack release, this procedure uninstalls the entire TIBCO BusinessEvents
installation, not just the service pack. It is not possible to uninstall only the service pack.

Uninstall in GUI mode
To uninstall TIBCO BusinessEvents in the GUI mode, do the following:

Procedure

1. Do one of the following to start the uninstaller:

● Navigate to the TIBCO_HOME/tools/universal_installer directory and run the
TIBCOUniversalInstaller program.

● (Windows) From the Start menu, select Start > All Programs > TIBCO > TIBCO_HOME >
Uninstall.

● (Windows) Use Add/Remove Programs from the Control Panel.

2. The Welcome screen appears. Click Next.

3. Do one of the following:

● To uninstall only a selection of products in this TIBCO home, click Custom Uninstall. Select
the product or products you want to uninstall. Then click Next. See TIBCO BusinessEvents®
Enterprise Edition Components for guidelines.

● To uninstall all TIBCO products in this TIBCO home (that were installed using the universal
installer), click Typical Uninstall. Then click Next.

4. The Pre-Uninstall Summary screen appears. Click Uninstall. Uninstallation proceeds and then you
see the Post-Uninstall Summary.

5. Click Finish to close the uninstaller window.

6. If you are prompted to do so, restart the computer.

You may also want to manually delete any remaining files in the installation directory to completely
remove the product.

Result

For information on the uninstallation log files, see Installation History Log Files.

Uninstall in Console Mode
To uninstall TIBCO BusinessEvents in the console mode, do the following:

Procedure

1. Open a console window and navigate to the directory:

TIBCO_HOME/tools/universal_installer

2. Run the TIBCOUniversalInstaller in console mode using the command:
TIBCOUniversalInstaller -console

3. Respond to the prompts on the console window to uninstall the software.
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Uninstalling in Silent Mode
Uninstalling in silent mode allows you to uninstall without user inputs by pointing to a response file.
For uninstallation, you need to create a response (.silent) file with the needed uninstallation
parameters. You can use the .SILENT file provided with the installation package as a template.

Use the -silent command for performing the silent uninstallation. Pass the absolute path of the
response file as an argument if the response file is not located in the same folder as
TIBCOUniversalInstaller.

Prerequisites

A .SILENT file should exist with values for atleast the following attributes:

● uninstallProductID

● uninstallProductVersion

● uninstallTIBCOHome

Procedure

1. Open a command line, navigate to the directory:
TIBCO_HOME/tools/universal_installer

2. Run the TIBCOUniversalInstaller in silent mode using the following command based on the
response file location:
Response File Location Silent Uninstallation Command

TIBCO_HOME/tools/

universal_installer

TIBCOUniversalInstaller -silent

Other TIBCOUniversalInstaller -silent -V

responseFile="<absolute_path_and_file_name>"

The following sample content of the Uninstall.silent file removes all products from the
specified TIBCO_HOME: C:\BE\BE520.
<?xml  version="1.0"?>
<!DOCTYPE properties SYSTEM "http://java.sun.com/dtd/properties.dtd">
<properties>
<comment>---Universal Installer Silent Installation Properties---</comment>

<entry key="uninstallProductID">*</entry>
<entry key="uninstallProductVersion">*</entry>
<entry key="uninstallTIBCOHome">C:\BE\BE520</entry>

</properties>
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Existing Eclipse (or TIBCO Business Studio) Installation

This section is optional, for those using an existing eclipse installation instead of one provided with
TIBCO BusinessEvents.

Using an existing Eclipse (or TIBCO Business Studio) installation is possible only for releases with full
installers. It is not possible for releases with partial installers, such as service pack releases.

TIBCO BusinessEvents Studio is compatible with the Eclipse P2 provisioning system. You can choose to
install TIBCO BusinessEvents Studio on an existing Eclipse installation using one of the following
approaches:

● Executing the script install_studio_repo available at BE_HOME/studio/repo. See Install Using
the Script install_studio_repo for details.

● Using Ant to run the build file available at BE_HOME/studio/repo. See Install Using Ant for details.
● Copying the links and updating the .ini files manually. This is applicable only when installing on

an existing basic Eclipse installation and not on TIBCO Business Studio. See Install Manually by
Copying Links and Updating .ini Files for details.

Eclipse Requirements
TIBCO recommends using the Eclipse software bundled with the TIBCO BusinessEvents software.
However, if you prefer to use your existing Eclipse software installation, or want to install Eclipse
separately, or want to install TIBCO BusinessEvents for use with the TIBCO Business Studio business
modeling software product, you must update the existing Eclipse installation with the required plug-
ins. You can do this before or after installing TIBCO BusinessEvents.

The Eclipse requirements are:

● Eclipse release 4.5.2
● Eclipse Delta Pack 4.5.1
● Eclipse Modeling Framework (EMF) release 2.11.1
● EMF Transaction 1.9.0
● EMF Validation 1.9.0
● Eclipse Graphical Editing Framework (GEF) release 3.10.0
● Eclipse Process Framework (EPF) Richtext Feature release 1.5.1.6
● Model Development Tools (MDT) UML release 5.1.0
● Eclipse Web Tools Platform (WTP) release 3.6.0

Eclipse Installation
Perform the following tasks to ensure that the dependencies required by Eclipse and TIBCO
BusinessEvents are installed and available:

Procedure

1. Download the files listed in Eclipse Requirements from the Eclipse Foundation website.

This step is optional if the script install_studio_repo is used as described in Install Using the
Script install_studio_repo.

2. If you have not already done so, install the Eclipse release.

3. Extract the other components (Delta Pack, EMF, GEF, MDT, and WTP) to the top-level directory of
your Eclipse installation.
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4. Install TIBCO BusinessEvents (and one or more add-on products if required) as explained in 
Installing TIBCO BusinessEvents. Remember to select the Use my own Eclipse installation check
box.

The TIBCO BusinessEvents products can be installed before installing the Eclipse
software. Ensure that all of them are installed before proceeding to the next step.

5. Choose one of the following approaches to install TIBCO BusinessEvents Studio:

● Install Using the Script install_studio_repo

● Install Using Ant

● Install Manually by Copying Links and Updating .ini Files

Install Using the Script install_studio_repo

This option is available only if the Eclipse Platform feature is installed when installing TIBCO
BusinessEvents. If the Eclipse Platform feature is not installed, you can use Ant to install TIBCO
BusinessEvents Studio as described in Install Using Ant.

When you install TIBCO BusinessEvents (and one or more add-ons), the TIBCO BusinessEvents Studio
repositories are installed under BE_HOME/studio/repo. For each of the installed products, a folder
with the product name is created under BE_HOME/studio/repo.

Scripts are provided with the repositories to install on an existing Eclipse installation.

Procedure

1. Using a console window, navigate to BE_HOME/studio/repo and run the following command (on
Windows):

install_studio_repo.bat <absolutePathOf_YourEclipse>/eclipse.exe

2. The script performs the following tasks:

● installs the TIBCO BusinessEvents Studio repositories for all the installed products.

● checks if the dependencies are available. If they are not available, the script downloads the
dependencies from the Eclipse download site.

If the dependencies are not available, you must ensure that the machine has network
connectivity to enable to script to download the required files. This may take a while
to complete.

● Updates the following properties in Your_Eclipse/eclipse.ini file:

-DBE_HOME=path to BE_HOME

-Dstudio.wrapper.tra.file=<path to BE_HOME>/studio/eclipse/configuration/

studio.tra

-DJDK_LIB=TIBCO_JAVA_HOME/lib

The script uses JRE 1.8 that is provided with TIBCO BusinessEvents. To use a
different JDK, edit the property DJDK_LIB and specify the absolute path of the JDK
that is to be used.

The script throws an error with an appropriate message if the Eclipse executable or the
eclipse.ini files are missing.

3. Once the execution is completed, start Eclipse and open the BusinessEvents Perspective to access the
TIBCO BusinessEvents Studio features.
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Install Using Ant
This option does not require the Eclipse Platform feature to be installed when installing TIBCO
BusinessEvents. Ensure that Ant is installed and available in your environment.

Procedure

1. Install TIBCO BusinessEvents Studio on an existing Eclipse installation by executing the command:

ant -buildfile install_studio_repo.xml -DappBinary=<absolutePathOf_YourEclipse>/eclipse.exe -
DappIni=<absolutePathOf_YourEclipse>/eclipse.ini

2. The script performs the tasks described in Install Using the Script install_studio_repo.

3. Once the execution is completed, start Eclipse and open the BusinessEvents Perspective to access the
TIBCO BusinessEvents Studio features.

Install Manually by Copying Links and Updating .ini Files
This approach can be used to install on any existing standard Eclipse installation only.

This approach does not support installing TIBCO BusinessEvents Studio on TIBCO Business Studio.

Procedure

1. Copy the files TIBCOBusinessEvents-Studio-plugins.link and TIBCOBusinessEvents-
EclipsePlatform-plugins.link from BE_HOME/studio/eclipse/dropins_configuration to
Your_Eclipse/links.

2. Configure the Your_Eclipse/eclipse.ini file as follows:

● Ensure that the VM setting is done for Java 1.8 JVM. Path should appear in a new line:

–vm

path to JRE 1.8

● Add the following properties to -vmargs, each on a new line
-DBE_HOME=path to BE_HOME
-Dstudio.wrapper.tra.file=<path to BE_HOME>/studio/eclipse/configuration/
studio.tra
-DJDK_LIB=path to JRE 1.8/lib

3. Change directory to the Your_Eclipse location and run the command:
eclipse -clean –initialize

4. Run the command eclipse.

Running this command loads Eclipse with the BusinessEvents Studio plug-ins.
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Post Installation Tasks

This chapter explains some post-installation steps you may have to perform in your installation.

Also see Migrating Projects from Earlier Versions for additional procedures you may have to do after
installation.

Post Installation Tasks for All Platforms

This section explains changes that are required in the circumstances shown.

Also see JVM Settings in Properties Files in case it pertains to your situation.

Migrating Projects

For all projects created using prior releases, you must perform migration steps. After you migrate, you
must also rebuild the EAR files for the projects, as is always the case when you upgrade. See Migrating
Projects from Earlier Versions and carefully follow all instructions.

Re-Initialize Studio Plug-ins Registry after Add-on Software Installation
When you install add-on products after installing TIBCO BusinessEvents, you need to ensure that the
correct plug-ins contributed by the add-ons are initialized. To do this, re-initialize the studio plug-ins
registry before you start using TIBCO BusinessEvents Studio, as explained next.

Procedure

1. To re-initialize Studio plug-ins, open a command prompt.

2. Change directory to BE_HOME/studio/eclipse.

3. Run the command
studio -clean -initialize

JVM Settings in Properties Files

This task is required for full installations. It is not typically required for service pack installations. It is
valid on all platforms.

Check the engine properties file to ensure that all settings are appropriate for your platform.

Set the Heap Size as Needed

By default, the initial (–Xms) and maximum (–Xmx) heap size are set to 1GB for both TIBCO
BusinessEvents and TIBCO BusinessEvents Decision Manager. Change the settings as needed to meet
your requirements. For TIBCO BusinessEvents, the settings are in the BE_HOME/bin/be-engine.tra
file. For TIBCO BusinessEvents Decision Manager they are in the BE_HOME/decisionmanager/
eclipse/DecisionManager.ini file.

You can also set the stack size for each thread using the -Xss option.

For example, if you want to run both TIBCO BusinessEvents Decision Manager and TIBCO
BusinessEvents on a machine with 1GB memory, you might reduce the initial heap size setting (–Xms):
java.extended.properties=-server –Xms512m -Xmx1024m -Xss2m

As another example, if you use a machine with more memory, and you work with very large tables in
TIBCO BusinessEvents Decision Manager, you might increase the TIBCO BusinessEvents Decision
Manager heap size accordingly.
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It can also be helpful to set the MaxPermSize as follows:
-XX:MaxPermSize=128m

Platform-Specific Settings

Some of the JVM settings do not work for all platforms, and some platforms use additional, platform-
specific parameters. For example:

For 64 bit Sun JVM for Intel or AMD on Linux, use
JVM_LIB_PATH=%TIB_JAVA_HOME%/lib/amd64/server/libjvm.so

For 64 bit Sun JVM for Intel or AMD on Windows, use:
JVM_LIB_PATH=%TIB_JAVA_HOME%/lib/amd64/server/libjvm.dll

For AMD on Windows and 32 bit Sun JVM for Intel use:
JVM_LIB_PATH=%TIB_JAVA_HOME%/lib/i386/server/libjvm.dll

The IBM AIX platform uses parameters common to all JVMs, but does not use the -d64 parameter. AIX
also uses additional parameters (using the format, -Xparameter).

Refer to the appropriate JVM reference manuals for the platform in question. For example, for AIX you
could refer to the following resources.

http://www.ibm.com/developerworks/java/jdk/aix/j564/sdkguide.aix64.html

http://www.ibm.com/developerworks/java/jdk/aix/j532/sdkguide.aix32.html

Note that on AIX, you can determine the mode in which JVM is running using the following simple
Java program:
System.getProperty("com.ibm.vm.bitmode");

It returns the following values:
* 32 - the JVM is running in 32-bit mode
* 64 - the JVM is running in 64-bit mode

Software Configurations Required for the Mac OS Platform
In the MacOS platform, TIBCO BusinessEvents Studio and TIBCO BusinessEvents Decision Manager
add-on requires Java 6 for launching. If you do not want to install Java 6, you can use some workaround
to launch Studio.app and Decisionmanager.app applications.

You can use either of these workarounds

● You can launch Studio.app and Decisionmanager.app using binary executable files present at the
following locations:

— BE_HOME/studio/eclipse/studio.app/Contents/MacOS/

— BE_HOME/decisionmanager/eclipse/decisionmanager.app/Contents/MacOS/

● If you want to directly run Studio.app and Decisionmanager.app, you can edit the JDK
installation file to update the JVMCapabilities dictionary. The JDK installation file is located at /
Library/Java/JavaVirtualMachines/jdk1.8.0_x.jdk/Contents/Info.plist. Update the
JVMCapabilities dictionary with the following values:
<key>JVMCapabilities</key>
<array>
<string>CommandLine</string>
<string>JNI</string>
<string>BundledApp</string>
<string>WebStart</string>
<string>Applets</string>
</array>
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All UNIX Installations — Directory Permissions

● This task is required for full installations. It is not typically required for service pack installations.

● This step is required on all UNIX platforms.

● If you use TIBCO BusinessEvents Decision Manager, refer to its installation guide for additional
actions.

This section explains what directory permissions must be set to enable users to use the system.

Permissions for TIBCO BusinessEvents Directories

All TIBCO BusinessEvents users must have read, write, and execute permissions for the following
directories:
bin Directory
$TIBCO_HOME/be/<version_number>/bin

For example, if TIBCO BusinessEvents has been installed in /opt/tibco, the user who installed TIBCO
BusinessEvents should execute the following commands:
% chmod 755 /opt/tibco/be/<version_number>/bin/

(Other changes can be made using the chown command as needed.)

You can verify ownership and permissions using the long listing command, ls -l.

Configuration for 64-bit Mode
The following platforms allow you to run TIBCO BusinessEvents in 64-bit mode. See the product
readme for versions supported:

● AIX

● HP-UX Itanium

● Linux

● Solaris 10 SPARC

● Solaris 10 X86

An additional step is required for the HP-UX platforms. See Configure for HP-UX ). For
Microsoft Windows, a 64-bit installer is available from the download site.

Configure for 64-bit Mode

Procedure

1. Open all TRA files for editing. Do this for TIBCO BusinessEvents and for each add-on product used:

BE_HOME/bin/be-engine.tra

BE_HOME/bin/be-jdbcdeploy.tra

BE_HOME/bin/be-migration.tra

BE_HOME/rms/bin/be-rms.tra

BE_HOME/views/bin/be-views.tra

(be-rms.tra is used with TIBCO BusinessEvents Decision Manager and be-views.tra is used
with TIBCO BusinessEvents Views).
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2. To increase the heap size used by the engine, in each TRA file modify the values of –Xms and –Xmx in
the java.extended.properties parameter. For example, some common values are as follows:
-d64 -XX:MinHeapFreeRatio=52 -XX:MaxHeapFreeRatio=90 -XX:GCTimeRatio=19 -Xms1024m -
Xmx1024m -javaagent:%BE_HOME%/lib/cep-base.jar -XX:MaxPermSize=256m -XX:+UseParNewGC
-XX:+UseConcMarkSweepGC

3. Modify %BE_HOME%/bin/be-engine.tra.

4. Append %RV_HOME%/lib/64 to tibco.env.LD_LIBRARY_PATH .

● Alternatively, you can run as root:

a) Edit /etc/ld.so.conf .
b) Add the actual path %RV_HOME/lib/64.
c) Run ldconfig.

If you do not perform steps 3 and 4, an error similar to the following might occur when
you start the application: java.lang.UnsatisfiedLinkError:/opt/tibco/
tibrv/8.3/lib/libtibrvjsd64.so:libssl.so.0.9.8:wrongELF class: ELFCLASS32.

Configure for HP-UX
If you are using an HP-UX platform:

Procedure

1. Open the be-engine.tra file.

2. Remove the following entry from the property java.extended.properties property:

-javaagent:%BE_HOME%/lib/cep-instrumentation.jar

(If this property is present, the executable fails to launch.)

Enabling 64-bit Properties
By default, the 32-bit java.extended.properties are enabled.

Comment the 32-bit java.extended.properties and enable the 64-bit java.extended.properties
in the TRA files in these folders:
BE_HOME/bin/be-engine.tra
BE_HOME/rms/bin/be-rms.tra

Installing Oracle ECC Library Manually
If you have performed a customized installation of TIBCO BusinessEvents and have not selected the
Oracle Elliptic Curve Cryptography (ECC) component during installation, you can still install the
Oracle ECC library manually.

For information about installing Oracle ECC library during TIBCO BusinessEvents installation, see 
Installing in GUI Mode.

Procedure

1. Download your platform-specific Oracle ECC LGPL assembly from http://public.tibco.com/pub/
tibco_oss/sunec/.

2. Extract the ZIP archive to a temporary location.

3. In the extracted folder, browse to the Oracle ECC library file for your operating system (for
example, sunec.dll for Windows) and copy it to TIBCO_HOME/tibcojre64/11/bin.
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4. Restart the TIBCO BusinessEvents engine.

Adding Installation or Build Script for OpenSSL for Tomcat
You need to add installation or build script for Windows and Linux (Debian and Red Hat) for OpenSSL
for Tomcat, which will provide SSL support for the HTTP channel, when the Identity Resource is of the
type Certificate/KeyURL.

● Procedure mention in this section are not mandatory for TIBCO BusinessEvents installation. Use
this information, only when you need to enable Open SSL for Tomcat.

● Tomcat Native 1.1.32 or 1.1.33 and OpenSSL 1.0.2 onwards are required to build libraries, which are
compatible with Tomcat 7.0.62 onwards.

Setting Up OpenSSL on Windows

Procedure

1. Save the tcnative-1.dll file in a directory. The file can be found under TOMCAT_HOME\bin in the
Tomcat installation. You can download Tomcat from the following URL:

http://archive.apache.org/dist/tomcat/tomcat-7/v7.0.64/bin/

2. Provide the path to this directory in the TRA file using the java.library.path property.
java.library.path=<dllDirectoryPath>

Setting Up OpenSSL on Linux (Debian & Red Hat)

Procedure

1. Install Apache Portable Runtime (APR) and OpenSSL. OpenSSL is already available in most linux
setups.

For Debian based Linux use the following command:
apt-get install build-essential libapr1-dev libssl-dev

For Red Hat, download source (the .tar.gz file) for APR from http://apr.apache.org/download.cgi
Now run the following commands:
tar xvzf apr-1.5.1.tar.gz
cd apr-1.5.1
./configure
make
make install

2. Note down the path shown at the end of the command make install. This directory contains the
apr-1-CONFIG file, which is used for building the Tomcat native library.

3. To build Tomcat native library, extract tomcat-native.tar.gz, which is located under
TOMCAT_HOME/bin/tomcat-native.tar.gz, to a local directory (for example, home/user/
tomnative). You can download Tomcat from the following URL:

http://archive.apache.org/dist/tomcat/tomcat-7/v7.0.64/bin/

4. Browse to the native library in the extracted directory (for example, home/user/tomnative/tomcat-
native-1.1.32-src/jni/native) and run the following commands:
/configure -with-apr=1-CONFIG> -with-java-home= -with-ssl=yes -
prefix=destinationDirectoryForLibrariesInstallation
make
make install
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To verify if the installation is successful, browse to the destination directory provided for libraries
installation and check if it contains five new files (with .so, .la and .a extensions).

5. Provide the path of the destination directory provided for libraries installation in the TRA file.

LD_LIBRARY_PATH= destinationDirectoryForLibrariesInstallation
export LD_LIBRARY_PATH
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Migrating Projects from Earlier Versions

Read this chapter carefully and follow all migration steps that apply to your case.

For non-project related actions required for various situations, see Post Installation Tasks .

Migration of add-on products is also included, so that all migration information is available in one
place.

Many of the actions you must take to migrate projects to the current release depend on the version you
are migrating from, and the features you use. Some manual steps are required. More manual steps are
required for earlier versions than for 4.x projects due to the changes in architecture.

Read the rest of this section and then check the section for the release from which you are migrating:

● If you are upgrading from 5.0 to 5.1, the CDD model needs to be refreshed. See Migration from 5.0
to 5.1 for details.

● If you are upgrading from 4.0, first upgrade to 4.0.1 and then migrate to 5.1. See Migration of 4.x
Projects, and referenced sections.

● If you are upgrading from 3.x, you can migrate directly to 5.0 and then to 5.1. Follow the manual
steps as required. See Migration of 3.x Projects, and referenced sections.

● If you are upgrading from a version earlier than 3.0, first upgrade to the latest 3.x version, following
directions in the 3.x documentation.

No migration steps are required for JDBC backing store implementations or data. JDBC
backing store was first made available in 3.0.1 Hotfix 6.

Check Release Notes

In all cases, check all sections in the Release Notes of the product, available at https://docs.tibco.com,
and take action accordingly.

Migrating from Coherence to TIBCO BusinessEvents DataGrid Cache
Provider

TIBCO DataGrid cache provider feature replaces Coherence as the built-in cache provider in version
5.0.0. A set of core Coherence functions has been renamed (and additional internal changes have been
made) so that these functions can be used with either the Coherence or the TIBCO BusinessEvents
DataGrid cache provider. The renamed functions are in the Standard catalog Cluster.DataGrid
category.

See Mapping of Coherence Functions to TIBCO BusinessEvents DataGrid Functions for details.

When you migrate to the current release with TIBCO BusinessEvents DataGrid as the cache provider,
certain Coherence functions are not migrated. In particular, the functions in the following categories are
not migrated:

● Standard/Coherence/Constants

● Standard/Coherence/Extractors

● Standard/Coherence/Filters

● Standard/Coherence/Query

If you are concerned that your projects may require some recoding, contact your TIBCO representative
for more details.

A TIBCO BusinessEvents Studio refactoring operation, and a TIBCO BusinessEvents Studio Tools
command line option are available to do the function migration for specific purposes other than general
migration.
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Fixing Errors Due to Use of Words in Reserved Word List

As TIBCO BusinessEvents develops, the number of reserved words increases. For the current list of
reserved words, refer to Rule Language Grammar as well as Keywords and Other Reserved Words in
TIBCO BusinessEvents Developer's Guide.

Validation shows errors for use of keywords as identifiers:
Reserved keyword, cannot be used as an identifier

To Resolve the Issue
 If you use any of the listed words as identifiers, resource names, or folder names, change them in
your project.

Migrating with Berkeley DB Object Management
Berkeley DB OM, formerly called Persistence OM, is an older form of data persistence. Support for this
option is removed in version 5.1.

You can migrate to Cache OM with backing store.

There is no direct migration path from the Berkeley DB OM database to a JDBC backing store.
Migration is a two-stage procedure:

Procedure

1. As needed, upgrade using the latest 3.x or 4.x version of TIBCO BusinessEvents. Those versions
have a utility to migrate the data to the legacy backing store schema, the Oracle Types backing store
schema.

2. Migrate from the Berkeley DB database to the legacy Oracle Types backing store. To complete this
step, follow instructions in the TIBCO BusinessEvents Installation guide for the version you are
using for this step of the migration.

3. Migrate from the Oracle Types backing store to the JDBC backing store, following instructions in 
Oracle Types to JDBC Backing Store Migration.

4. Migrate the project to 5.1.

● If you are using the latest 5.x version, see Migration from 5.0 to 5.1.

● If you are using the latest 4.x version, see Migration of 4.x Projects.

● If you are using the latest 3.x version, see Migration of 3.x Projects.

Migration from 5.0 to 5.1

This section provides information about the manual tasks that need to be performed when migrating
from 5.0 to 5.1. See Migration from 4.x to 5.1 if you are migration older projects to 5.1.

Changes to the CDD File

Import your project into a 5.1 workspace and edit the CDD file to remove the newly added element
<enabled>false</enabled> from under the backing store entries for the cluster tab.

Entries related to the load balancer and process-groups can remain as is.
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Migration from 5.0 to 5.1 for Add-on Products
In addition to migration content for TIBCO BusinessEvents, migration of add-on products is
documented in this chapter for your convenience.

TIBCO BusinessEvents Views

● Automatic Changes

Migrates About This Chart text
 The About this Chart property has been removed from charts. When projects from the prior
release are migrated to the current release, the text from those properties is appended to the chart
description.

● Manual Changes

Changes to Logo Image and Branding Image Handling
 The method of including branding images has been improved. Images are now stored in the
TIBCO BusinessEvents Studio project. To migrate to the new method do the following.

● Open the project in TIBCO BusinessEvents Studio, and select File > Import > File System . Use
the Eclipse dialog to locate the image file or files you want to use, and import them into a
project folder. /Dashboards/Images is the recommended location.

Edit the Login and Header resources. In the ImageURL field, browse to the project folder where
the imported graphic is located and select it.

Migration from 4.x to 5.1

All changes listed in the section Migration from 5.0 to 5.1 need to be performed in addition to the
changes described below.

Manual Change

When migrating 4.x projects, edit the CDD file and set the cluster level property
be.engine.cluster.as.discover.url with a valid value (for example, tibpgm://9995/) preferably
inside a property group "tibas".

No migration steps are required for JDBC backing store implementation or data

Automatic Changes

The migration utility automatically does the following:

Migrates core Coherence functions to product neutral ones
 A set of core Coherence functions has been renamed so that these functions can be used with either
the Coherence or the TIBCO BusinessEvents DataGrid cache provider. Not all Coherence functions are
migrated. See Migrating from Coherence to TIBCO BusinessEvents DataGrid Cache Provider for
important information.

Migrates the channel driver type  
Driver type is migrated from the 4.0 format to the current format.

Migrates HTTP channel settings
 HTTP channel tuning settings are now maintained in the channel resource instead of the processing
unit (PU) area of the CDD. During the migration process, you specify the CDD and within it the PU
whose settings you want to migrate. Settings from the selected PU are applied to all HTTP channels.
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Migrates CDD file namespaces
 Namespace is changed to the following: http://tibco.com/businessevents/configuration/5.1.

Migrates entity metadata properties to CDD domain object override settings
 In earlier versions, entity-specific configuration for cache and backing store was done using metadata
properties (also known as extended properties). It is now done in the CDD only. The migration utility
moves all relevant metadata property settings to the equivalent settings in the CDD Domain Objects
Overrides area. An override is added for each entity type. You can later remove unnecessary entries as
needed. (There is no change to configuration for metadata properties used by the TIBCO
BusinessEvents Data Modeling add-on product.)

Migrates localStorage Property to isSeeder property (partial migration)
  The property  tangosol.coherence.distributed.localstorage is migrated to the cache-
provider-neutral property be.engine.cluster.isSeeder. However, a change in design makes this
property redundant. Cache storage is now set at the processing unit level, using a checkbox labeled
Enable Cache Storage. It is not possible to set this checkbox at migration time. Note that without
further action, if the isSeeder property is set higher in the order of precedence than the processing
unit, then the isSeeder property is used at runtime. However, if the isSeeder property is set lower in
the order of precedence than the processing unit, then the checkbox value is used. To complete
migration, remove the isSeeder property and instead use the processing unit setting Enable Cache
Storage in the project CDD file. Note that enabling cache storage on non-cache agents is not
recommended for production. It can be useful for testing and demonstration purposes.

Add-on Product Migration

Migrates TIBCO BusinessEvents Views default skin
 TIBCO BusinessEvents Views has a new look-and-feel. The default skin is migrated automatically. If
you use this add-on product, you can view the default skin settings using the view-only System
Elements resource. See TIBCO BusinessEvents Views Developer’s Guide for details about how you
can use the System Elements when you define your own color schemes and skins.

Migrates TIBCO BusinessEvents Decision Manager metadata location
 Metadata information for decision tables was being stored in the (internal) .beproject file. Now it is
stored in the decision table file itself.

Mapping of Coherence Functions to TIBCO BusinessEvents DataGrid Functions

4.x Coherence Category Function Name DataGrid Category Function Name

C_CacheGetEntityById() CacheGetEntityById()

C_CacheLoadConceptByExtId() CacheLoadConceptByExtId()

C_CacheLoadConceptById() CacheLoadConceptById()

C_CacheLoadConceptIndexedByExtId() CacheLoadConceptIndexedByExtId()

C_CacheLoadConceptsByExtId() CacheLoadConceptsByExtId()

C_CacheLoadEntity() CacheLoadEntity()

C_CacheLoadEventByExtId() CacheLoadEventByExtId()

C_CacheLoadEventById() CacheLoadEventById()
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4.x Coherence Category Function Name DataGrid Category Function Name

C_CacheLoadParent() CacheLoadParent()

C_CacheName() CacheName()

C_CacheReevaluate() CacheReevaluate()

C_ClassName() ClassName()

C_EnableCacheUpdate() EnableCacheUpdate()

C_Index() Index()

C_Lock() Lock()

C_TransactionProperties TransactionProperties()

C_UnLock() UnLock()

Migration of 4.x Projects
This section outlines how to migrate 4.x projects, after you install TIBCO BusinessEvents 5.2.

Berkeley DB object management is removed from the product in version 5.1. If you are migrating from
Berkeley DB, see Migrating with Berkeley DB Object Management for preliminary steps to take in order
to change to Cache OM.

First Upgrade 4.0.0 Projects to 4.0.1

If you are running 4.0.0, first upgrade to 4.0.1. Open the 4.0.0 projects in TIBCO BusinessEvents Studio
and save them.

Importing Projects in TIBCO BusinessEvents Studio
A command line utility to do the same actions is also provided. After importing using the command
line utility an additional procedure is required before you can work with the project in TIBCO
BusinessEvents Studio.

See Import an Existing 4.x Project at the Command Line. For details about what is migrated, see 
Migration from 4.x to 5.1.

Procedure

1. After installing TIBCO BusinessEvents 5.2, start TIBCO BusinessEvents Studio using a different
workspace from the workspace containing the 4.x projects.

2. Select File > Import .
The Import wizard is displayed.

3. In the Import wizard, select TIBCO BusinessEvents > Existing TIBCO BusinessEvents Studio
Project and click Next.
The Existing TIBCO BusinessEvents Studio Project Import Wizard is displayed.

4. In the Existing project root directory field, click Browse and select the project root directory of the
project you are importing.
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5. Select the XPath version to be used for the project in the XPath Version drop-down.

6. Do one of the following:

● Select the Copy project into workspace checkbox. This option copies the project into your
current workspace.

● Clear the Copy project into workspace checkbox and specify an import location.

7. Do one of the following:

● If your project has no HTTP channels, click Finish (this is the only option).

● If your project has one or more HTTP channels, click Next.

8. If you clicked Next then in the Select Processing Unit window select the project CDD in the Cluster
Deployment Descriptor drop-down.

9. Select the processing unit in the Processing Unit drop-down that contains the HTTP properties to
be migrated.
An informational panel displays the settings that will be migrated.

10. Click Finish.
The imported project is displayed in the TIBCO BusinessEvents Studio.

TIBCO BusinessEvents Views CDD Change
If you use the TIBCO BusinessEvents Views add-on product, you may need to update the CDD for
changes to the following dashboard agent properties:

4.x Property 5.x Property

be.http.docRoot be.agent.dashboard.http.docroot

The default is BE_HOME/views/web-root

be.http.docPage be.agent.dashboard.http.docpage

The default value is index.html

Because the replacement properties now have default values, you only have to add the properties if you
need to set a non-default value.

Do the following depending on your use case:

● If you have not changed the provided 4.x property values, and do not need to use a non-default
value in 5.1, remove the 4.x properties from the CDD.

● If you changed the value for one or both of the above properties, rename the property or properties
to the 5.1 name (as shown above). Do this in the dashboard agent properties area of the CDD, for all
affected dashboard agents (or at a higher level as appropriate to the scope you want to use).

Cache Provider Selection (Cache OM only)
Beginning with TIBCO BusinessEvents 5.0.0, Oracle Coherence is no longer provided with TIBCO
BusinessEvents. An internal component, TIBCO BusinessEvents DataGrid, is used by default.

See Migrating from Coherence to TIBCO BusinessEvents DataGrid Cache Provider for important
information about migration of Coherence functions. If you use cache OM, action is required:

● If you want to switch from Oracle Coherence to TIBCO BusinessEvents DataGrid, you must
manually reconfigure the CDD file settings. See TIBCO BusinessEvents Configuration Guide for details.

38

TIBCO BusinessEvents® Installation



● If you want to continue using Oracle Coherence as the cache provider, you must acquire a licensed
copy of Oracle Coherence software and do some configuration. See TIBCO BusinessEvents
Configuration Guide for details on enabling use of Oracle Coherence as the cache provider.

● The property  tangosol.coherence.distributed.localstorage is migrated automatically to the
cache-provider-neutral property be.engine.cluster.isSeeder. However, a change in design
makes this property redundant. Cache storage is now set at the processing unit level, using a
checkbox labeled Enable Cache Storage. It is not possible to set this checkbox at migration time. To
complete migration, remove the isSeeder property and instead configure cache storage for non-
cache agents as needed use the processing unit setting Enable Cache Storage in the project CDD file.
Note that enabling cache storage on non-cache agents is not recommended for production. It can be
useful for testing and demonstration purposes.

Configuring Settings (Cache OM only)

Procedure

1. Migrate Legacy Oracle-only Backing Stores to JDBC Backing Store

2. The legacy Oracle-only (Oracle Types) backing store is no longer supported. If you were using the
legacy Oracle-only (Oracle Types) backing store, you must migrate to the current implementation.
See Oracle Types to JDBC Backing Store Migration.

3. (All Cases) Validate the Project in TIBCO BusinessEvents Studio.
It is recommended that you validate the project in TIBCO BusinessEvents Studio after migration, to
help ensure that the project is correctly configured. Certain validation checks were added after 4.0.
Validating the project may reveal issues that were not caught in the earlier release from which you
migrated.

4. Rebuild EAR Files

Result

As with any upgrade, you must rebuild all EAR files created with an earlier version.

Existing TIBCO BusinessEvents Project at the Command Line
This option is equivalent to the following menu option in TIBCO BusinessEvents Studio: File > Import >
TIBCO BusinessEvents > Existing TIBCO BusinessEvents Studio Project.

This is explained in Import Projects in TIBCO BusinessEvents Studio.

After you complete the procedures in this section, complete the migration tasks as shown following, as
needed for your project.

When you use this command-line (or TIBCO BusinessEvents Studio) option to import 4.x TIBCO
BusinessEvents Studio projects, the same migration actions are done as in the UI-based migration. See 
Migration from 4.x to 5.1

Before you can use a 4.x project imported at the command-line in TIBCO BusinessEvents Studio you
must do another procedure, explained in Open the Imported Project in TIBCO BusinessEvents Studio.
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Import an Existing 4.x Project at the Command Line

You can import projects from earlier versions or same version using command line utility. After
importing using the command line utility an additional procedure is required before you can work with
the project in TIBCO BusinessEvents Studio.

Procedure

1. Navigate to BE_HOME/studio/bin/ and open a command prompt.

2. Execute a command with the following format (all on one line) at a command prompt:

studio-tools -core importExistingProject [-h] -p studioProjDir [-o 
targetProjDir] [-c CDDprojectPath] [-u PUNameFromCDD] [-xp 1.0|2.0]

For example:
studio-tools -core importExistingProject -p C:\FT\SomeProj -o c:\MyWorkspace
\SomeProj -c COM.cdd -u Invproc -xp 2.0

If HTTP channel properties are migrated (from a specified CDD and processing unit to all HTTP
channel resources’ Advanced tab) you see a message like this:
Migrating HTTP properties of Processing Unit "PUName" from CDD "CDDprojectPath" 
to HTTPChannel(s) present in the project

When the import has completed successfully, you see a message in the command window like the
following:
The existing 4.0 TIBCO BusinessEvents project has been successfully imported to 
c:\MyWorkspace\SomeProj.

TIBCO BusinessEvents Studio Tools Options

TIBCO BusinessEvents Studio Tools Options for Importing an Existing Project

Option Description

-core 
importExistingProject

Specifies the importExistingProject operation for importing a
TIBCO BusinessEvents Studio project into the workspace.

-h Optional. Displays help.

-p Source project: absolute path to the project directory of the TIBCO
BusinessEvents Studio project to be imported.
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Option Description

-o Optional. Absolute path to the target project directory, where the
project is imported to.

If you specify the source project directory name as the last element in
the path, it is used as the target project directory. If you specify a
different directory as the last element in the path, the directory is
created if it does not exist, and the source project directory is
imported within the specified target directory.

If you do not specify a target project directory, the original project
contents are updated. If the project to be imported is a TIBCO
BusinessEvents version 4 project, it is no longer compatible with
version 4 after the import.

If the target location points to an existing project, the import does not
proceed and this message displays:
The specified target location already exists and cannot 
be used.

-c Optional. The CDD to use for migration actions. Project path of the
CDD (path relative to the root directory of the source project).

-u Optional. If specified, then the -c option must also be specified.
Specifies the name of the PU (within the specified CDD) that contains
settings to be migrated.

HTTP channel settings from this PU are migrated to all HTTP
channel resources in the project.

-xp Optional. The XPath version to be compatible with the project. The
values are:

● (default) 1.0

● 2.0

Open the Imported Project in TIBCO BusinessEvents Studio

To open a project imported at the command line, you must add it as a new project.

Procedure

1. Start TIBCO BusinessEvents Studio. In Windows, click Start > All Programs > TIBCO
<YourEnvironment> > TIBCO BusinessEvents <version_number> > TIBCO BusinessEvents Studio.

2. From the File menu select New > Project . You see the New Project > Select a Wizard dialog.

3. Select TIBCO BusinessEvents > Studio Project and click Next.

4. In the Project Name field, enter the directory name where the imported project is located. This is
used as the project name.

5. If you have imported the project to a directory in your default workspace, skip this step. If the
project directory is located outside the default workspace, uncheck the Use default location check
box and browse to the parent directory of the project imported at the command line.

6. Click Finish. The project folders appear in the Studio Explorer view.
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Migration of 3.x Projects
This section outlines how to migrate 3.x projects, after you install TIBCO BusinessEvents 5.5.

● If you are migrating 3.0.0 projects that use the legacy Oracle Types backing store, you must first
upgrade your 3.0.0 installation to the latest 3.x version and update the Oracle Types backing store
schema. After the schema update you can then migrate the data to the JDBC backing store, which
you configure in the 5.5 version project.

● Berkeley DB object management is removed from the product in version 5.2. If you are migrating
from Berkeley DB, see Migrating with Berkeley DB Object Management for preliminary steps to
take in order to change to Cache OM.

Import Clean and Validate the 3.x Project

Procedure

1. Import the TIBCO Designer (3.x) project into TIBCO BusinessEvents Studio. See Importing a 3.x
TIBCO Designer Project.

If you will migrate from the Oracle Types backing store or from a Berkeley DB OM to the Cache OM
with JDBC backing store, keep the 3.x project

2. In TIBCO BusinessEvents Studio select ProjectValidate to validate the project and then review the
issues in the Problems tab and in the Error Log tab and resolve any errors. See Clean and Validate
3.x Projects.

Configure Runtime Properties in the CDD File
Most of the configuration that was done in TRA files is now done in the CDD file. Ensure that all valid
3.x runtime settings (except JVM and system level properties) are configured in the CDD. Some
properties are not relevant in the current version, and additional properties not used in 3.x have been
added to the product. You may have to add some properties manually to CDD property sheets.

Here are some tips:

Procedure

1. Add runtime engine properties to the CDD file at the appropriate level for the scope of the
property:

● Cluster level for cluster-wide scope.

● Processing Unit level for engine-wide scope in the specified type of engine (Processing Unit).
You will have to think about your engines differently, as running different kinds of agent
classes.

● Agent level to limit the scope to the agent class.

2. TIBCO BusinessEvents properties that were configured in the TIBCO Designer TRA file generally
go in the TIBCO BusinessEvents Studio TRA file:

BE_HOME/studio/eclipse/configuration/studio.tra

3. Remove the runtime properties that are now configured elsewhere from the TRA file and ensure
that only JVM or system level properties remain. Leaving these properties in the TRA can cause
problems at runtime.
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Result

See CDD File Overview (For 3.x Users) for background information that helps you work with the CDD
file.

Check that be-engine.xml Settings are in the CDD File

Procedure

1. Change the CDD file values at deploy-time without having to rebuild the EAR file. After that, there
is no need for the be-engine.xml file. (It was used to add properties to the TIBCO Administrator
UI in order to make changes at deploy time.)

2. Check that all the properties from your 3.x be-engine.xml that are valid in 5.5 are present in the
CDD file.

Adding Project Libraries (If Used)
Version 3.x project libraries containing entities (concepts, events and so on) are not compatible with
project libraries in release 4.0.0 and higher, because the format for entities changed in the 4.0.0 release.
They are not migrated.

(3.x project libraries that contain only shared resources will work in version 4.0.0 and up, but that is not
a common use for project libraries. The format of shared resources remains the same in 5.5).

If you want to continue to use the 3.x project libraries, recreate the libraries and add them to the 5.5
project build path after migration. Refer to the "Working with Project Libraries" section, in the TIBCO
BusinessEvents Developer’s Guide.

Procedure

1. Reconfigure TIBCO BusinessEvents-ActiveMatrix BusinessWorks Integration Projects (If Used)

Configuration of TIBCO BusinessEvents-ActiveMatrix BusinessWorks integration projects has
changed. If a 3.x project contains TIBCO ActiveMatrix BusinessWorks or TIBCO Adapter resources,
plan to use two projects: a TIBCO Designer project for the TIBCO Designer resources, and a TIBCO
BusinessEvents Studio project. Refer to the TIBCO BusinessEvents Developer’s Guide for details.

The TIBCO ActiveMatrix BusinessWorks processes used in the integration project do not
appear in TIBCO BusinessEvents Studio. In version 3.x, both product UIs were
implemented in TIBCO Designer, but since version 4.0, the TIBCO BusinessEvents UI has
been implemented in Eclipse.

2. Migrate 3.x Decision Manager Projects (If Used)

Result

If you want to continue to use decision tables, you must purchase the TIBCO BusinessEvents Decision
Manager add-on product.

In a Decision Manager 3.x project, decision tables were in a separate project called a decision project, with
a .dp file extension (along with related files). Decision projects were maintained in a separate
application that is no longer used. The decision projects provided the decision tables for the TIBCO
Designer project that contained the virtual rule functions (implemented by the decision tables).

Import 3.x Decision Projects
To import 3.x decision projects you must first import the 3.x TIBCO Designer project into TIBCO
BusinessEvents Studio as a TIBCO BusinessEvents Studio project. Then you import the related decision
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project into that TIBCO BusinessEvents Studio project. The decision table format is migrated to the
current format during import.

Domain models are not imported while importing a decision project.

Procedure

1. Import the 3.x TIBCO Designer project into TIBCO BusinessEvents Studio as a TIBCO
BusinessEvents Studio project. See Import Clean and Validate the 3.x Project for full details.

2. In TIBCO BusinessEvents Studio, select Import from the File menu. You see the Import wizard
Select dialog.

3. Select TIBCO BusinessEvents > TIBCO BusinessEvents Decision Manager and click Next. You see
the Import Decision Project dialog.

4. In the Project Location field, browse to and select the decision project (.dp) file for the decision
project that relates to the TIBCO Designer project you imported in step 1.

5. In the Projects field, select the TIBCO BusinessEvents Studio project that you created by importing
the related TIBCO Designer project in step 1.

The decision tables are now added to the TIBCO BusinessEvents Studio project.

6. If you will use RMS, create the RMS project and copy project files to the appropriate folder so the
project can be checked out by Decision Manager UI users.

Migrate 3.x Database Concepts and State Models (If Used)
If you want to continue to use database concepts or state models, you must purchase the TIBCO
BusinessEvents Data Modeling add-on product.

After importing the project, you must configure the Cluster Definition Descriptor (CDD) file to add the
JDBC connection project path or paths, and enable database concepts on all engines (processing units)
where you want to use them. Steps are as follows:

Procedure

1. Open the project’s CDD and select the Cluster tab > Database Concepts.

2. In the Database URIs field, add all JDBC shared resources used for creating database concepts. Click
the plus sign to add a new row as needed, and add the project path to the resource.

3. Select the Processing Units tab (at the bottom of the window). Select each processing unit in turn
and do one of the following:

● To enable database concepts, check the Enable Database Concepts checkbox.

● To disable database concepts, uncheck the checkbox.

When cache OM is used, the default mode for a cache cluster is Cache Only. However
the default mode of a database concept is Memory Only. You can specify a mode
explicitly by adding domain object overrides. See TIBCO BusinessEvents Data
Modeling Developer’s Guide for complete details.

Choose a Cache Provider (Cache OM only)
Beginning with TIBCO BusinessEvents 5.0.0, Oracle Coherence is no longer provided with TIBCO
BusinessEvents. An internal component, TIBCO BusinessEvents DataGrid, is used by default.

See Migrating from Coherence to TIBCO BusinessEvents DataGrid Cache Provider for important
information about migration of Coherence functions. If you use cache OM, action is required:
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● If you want to switch from Oracle Coherence to TIBCO BusinessEvents DataGrid, you must
manually reconfigure the CDD file settings. See TIBCO BusinessEvents Configuration Guide for details.

● If you want to continue using Oracle Coherence as the cache provider, you must acquire a licensed
copy of Oracle Coherence software and do some configuration. See TIBCO BusinessEvents
Configuration Guide for details on enabling use of Oracle Coherence as the cache provider.

● The property  tangosol.coherence.distributed.localstorage is migrated automatically to the
cache-provider-neutral property be.engine.cluster.isSeeder. However, a change in design
makes this property redundant. Cache storage is now set at the processing unit level, using a
checkbox labeled Enable Cache Storage. It is not possible to set this checkbox at migration time. To
complete migration, remove the isSeeder property and instead configure cache storage for non-
cache agents as needed use the processing unit setting Enable Cache Storage in the project CDD file.
Note that enabling cache storage on non-cache agents is not recommended for production. It can be
useful for testing and demonstration purposes.

Configure Settings (Cache OM only)

Procedure

1. Migrate Legacy Oracle-only Backing Stores to JDBC Backing Store

The legacy Oracle-only (Oracle Types) backing store is no longer supported. If you were using the
legacy Oracle-only (Oracle Types) backing store, you must migrate to the current implementation.
See Oracle Types to JDBC Backing Store Migration.

2. (All Cases) Validate the Project in TIBCO BusinessEvents Studio

It is recommended that you validate the project in TIBCO BusinessEvents Studio after migration, to
help ensure that the project is correctly configured.

Certain validation checks were added after 4.0. So validating the project may reveal issues that were
not caught in the earlier release from which you migrated.

3. Rebuild EAR Files

As with any upgrade, you must rebuild all EAR files created with an earlier version.

CDD File Overview (For 3.x Users)
Beginning with the 4.0.0 release, most runtime properties and other deploy-time settings are configured
using a structured XML file called the Cluster Deployment Descriptor (CDD). A big advantage of this
change is that you can change CDD file values at deploy-time without having to rebuild the EAR file
(the CDD file used is stored outside the EAR file).

A multi-tab editor in TIBCO BusinessEvents Studio enables easy maintenance of this file. This section
explains the role of the CDD file for the benefit of those migrating projects from 3.x.

The EAR file now includes all resources
 In the current architecture, you do not select what resources to include in the EAR file. The EAR
includes all project resources and can be very large. During runtime however, the resources are
enabled (filtered) through the CDD Agent Classes and Collections tabs.

Read this section before beginning your migration. Also read related topics in TIBCO BusinessEvents
Architect’s Guide and TIBCO BusinessEvents Getting Started.

Documentation about the CDD settings and properties is provided in the TIBCO BusinessEvents
Cluster Deployment Descriptor Configuration Guide.
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Most Runtime Properties are Configured in the CDD File

3.x Configuration

In 3.x (and earlier), runtime properties were set using individual properties set in one or more TRA
files. In some cases, runtime properties were set in TIBCO Designer, specifically in the BAR resource,
and some were set in the TIBCO Designer TRA file.

5.2 Configuration

Now only JVM-level properties (those that need to be used before the engine starts up) are set in the
be-engine.tra file. Properties that were set in the TIBCO Designer TRA file (designer.tra) are now
generally set in the studio.tra file:
BE_HOME/studio/eclipse/configuration/studio.tra

Other runtime properties are configured in the CDD file. The CDD file provides fields for all commonly
used settings, and it has property sheets where you can add other properties as needed. The property
sheets are available at various levels, cluster, processing unit, and agent, so that you can scope the effect
of the property appropriately and provide overrides at lower levels.

Processing Units (Engines) and Agent Classes are Configured in the CDD File
In the CDD, you configure processing units (equivalent to an engine at runtime). A processing unit
references the agent or agents you want to include in the processing unit (engine) at runtime. At deploy
time you specify which processing units to deploy.

In 3.x agents were configured using individual properties in the TRA files. Each TRA file provided the
configuration for one engine.

Beginning with the 4.0.0 release, you configure all the processing units you need to deploy in a single
CDD file. When you deploy an engine, you specify the processing unit to use. The processing unit
configuration in the CDD determines which project resources and settings are used at runtime.

Some agents and processing units are created for you when you import a 3.x project into Studio based
on 3.x information available. After you import the project into TIBCO BusinessEvents Studio, edit the
CDD file to fully configure the agents and processing units as needed.

Metadata Properties (Extended Properties) are Configured in the CDD File

The entity metadata properties (also known as extended properties) for cache and backing store are
now configured in the CDD. Preloading configuration has also been simplified. This is explained in the
migration sections.

Importing a 3.x TIBCO Designer Project
You can directly import 3.x projects using the TIBCO BusinessEvents Studio user interface and save it
as a current version project. You can also import a 3.x project at the command line. Import from
versions earlier than 3.x is not supported.

After you import the project, see Clean and Validate 3.x Projects for the next step.

Importing a 3.x Project into TIBCO BusinessEvents Studio
To import 3.x projects into TIBCO BusinessEvents Studio, follow the procedure below.

Procedure

1. Start TIBCO BusinessEvents Studio. In Windows, click Start > All Programs > TIBCO >
Environment_Name > TIBCO BusinessEvents <version_number> > Studio.
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2. From the File menu, select Import. You see the Import wizard Select dialog.

3. Select TIBCO BusinessEventsTIBCO Designer and click Next. You see the TIBCO Designer Project
Import Wizard.

Importing a 3.x Project into TIBCO BusinessEvents Studio

4. In the Archive Location field, browse to the location of the TIBCO Designer project and select its
EAR file or its vcrepo.dat file.

5. In the Project Name field, enter a name for the TIBCO BusinessEvents Studio project. The default
value is the original project name.

6. Select the XPath version to be used for the project in the XPath Version drop-down.

7. Specify a project location, or use the default workspace.

8. Click Finish.

Result

The progress bar displays while the import is done. The status bar at the bottom of the window also
displays progress. When the import is complete, you see the project folders in the Studio Explorer view.
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Importing a TIBCO BusinessEvents 3.x Project at the Command Line
This utility imports a TIBCO BusinessEvents 3.x (TIBCO Designer) project at the command line.
Projects imported using this command-line utility do not run in the context of Eclipse (TIBCO
BusinessEvents Studio). An additional step is required if you want to open the project in TIBCO
BusinessEvents Studio, as explained below.

Procedure

1. Navigate to BE_HOME/studio/bin/ and open a command prompt.

2. Execute a command with the following format (all on one line) at a command prompt:
studio-tools -core importDesigner -d designerProjDir [-n studioProjName] -p 
studioProjDir [-xp XPathVersion]

For example:
studio-tools -core importDesigner -d C:\FT\FT_Project -n FTImport -p 
c:\myWorkspace\FTImported -xp 2.0

When the import has completed successfully, you see a message in the command window:
Imported the Designer Project successfully.

TIBCO BusinessEvents Studio Tools Options

TIBCO BusinessEvents Studio Tools Options for Importing 3.x TIBCO Designer Projects

Option Description

-core importDesigner Within the core category of operations, specifies the
importDesigner operation for importing a TIBCO BusinessEvents
3.x (TIBCO Designer) project.

-d Absolute path to the TIBCO Designer project directory (the .dat file
can be included but is not required). Import of release 3.x projects is
supported.

-n Optional. Specifies the name of the TIBCO BusinessEvents 4.x project
(TIBCO BusinessEvents Studio project). If not specified, the TIBCO
BusinessEvents Studio 3.x project name is used.

-p Absolute path to the TIBCO BusinessEvents 4.x project directory (the
TIBCO BusinessEvents Studio project). The directories in the path are
created if they do not exist.

-xp Optional. The XPath version to be compatible with the project. The
values are:

● 1.0

● 2.0

See Open the Imported Project in TIBCO BusinessEvents Studio for a procedure you must do if you
want to open the project in TIBCO BusinessEvents Studio

Opening the Imported Project in TIBCO BusinessEvents Studio
To open a project imported at the command line, you must add it as a new project.
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Procedure

1. Start TIBCO BusinessEvents Studio. In Windows, click Start > All Programs > TIBCO
<YourEnvironment> > TIBCO BusinessEvents <version_number> > TIBCO BusinessEvents Studio.

2. From the File menu select New > Project . You see the New Project — Select a Wizard dialog.

3. Select TIBCO BusinessEvents > Studio Project and click Next.

4. In the Project Name field, enter the directory name where the imported project is located. (This is
used as the project name.)

5. (If you imported the project to a directory in your default workspace, skip this step.) If the project
directory is located outside the default workspace, uncheck the Use default location checkbox and
browse to the directory of the project imported at the command line.

6. Click Finish. The project folders appear in the Studio Explorer view.

Clean and Validate 3.x Projects
This section explains how to clean and validate a 3.x project, and how to fix errors.

Executing Project > Clean also performs validation, if you check Project > Build Automatically. In this
case you do not have to do step 2 .

After you import the 3.x project into TIBCO BusinessEvents Studio Explorer, do the following:

Procedure

1. Highlight the project name in TIBCO BusinessEvents Studio and select Project > Clean. At the
Clean dialog, click Clean projects selected below, and then select the imported project. Click OK.

All build problems and build states are discarded. The project is rebuilt from scratch.

2. Highlight the project name in Studio Explorer and select Project > Validate to validate the project.

Result

You may see some common validation errors that are addressed in the following sections. If you see
additional errors that you cannot resolve, contact your TIBCO representative for assistance.

Fixing Reference and XSLT Mapper Errors

Ambiguous Reference Errors (Unqualified References)

During migration, duplicate name references can cause issues. If the project contains unqualified
references to rules, rule functions, or ontology types, and any of the rules, rule functions, or ontology
types have the same simple name, duplicate name validation errors will result.

In the TIBCO BusinessEvents Studio Problems tab, you may see listings for these issues, such as the
following:
Ambiguous reference. Reference must be qualified, as multiple elements exist with 
the same name [/sharedResources/Element, Rules/Element, Concepts/Element]

One source of this issue is that beginning with the 4.0.0 release, rules are separate resources, whereas in
the 3.x product, they exist within ruleset resources.

To Resolve the Issue
 Qualify all such ambiguous references.
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XSLT Mapper Errors

If you have used the XPath (XSLT) mapper in TIBCO Designer, there could be errors that prevent a
clean validation of the project after it is imported.

In 3.x, XSLT Mapper errors were not reported during project validation. This validation has been
added, beginning with the 4.0.0 release. Therefore, any mapper errors must be fixed before project
validation can be successful. These errors existed in the 3.x product, though they may not have caused
any runtime problems.

To Resolve the Issue
 In TIBCO BusinessEvents Studio double-click those items in the Problems view. The rule editor
displays the corresponding rule or rule function. In the editor. Check for red error indicators on lines
containing function mapping. Where you see an error indicator on a line containing Mapper code,
Ctrl-click the underlined argument text to open the Function Argument Mapper dialog. Click the
Mapper Check and Repair (check-mark icon) button.

Some errors can be auto-fixed: Click the validate option (the check mark) in the mapper. You see the
Mapper Check and Repair dialog. Select the items you want to fix and click OK. (Using auto-fix is
harmless even if the errors cannot be auto-fixed.) Then manually fix any errors that cannot be
autofixed. For example, errors such as undefined variable errors cannot be fixed automatically.

Oracle Types to JDBC Backing Store Migration

The Oracle-only (Oracle Types) backing store is not supported in 5.0.0
 If you were using this backing store implementation in your prior version of TIBCO BusinessEvents,
implement a JDBC backing store and migrate your data to it as explained in this section.

If you were using the JDBC backing store in any release, no migration is required.

Migration steps depend on whether you are migrating from 3.0.0, or from a later 3.x release, or from a
4.x release, as indicated in the tasks below.

During migration, you must keep the JDBC Connection resource for the existing Oracle-only backing
store, and you must be able to connect to it.

The data migration process uses two backing stores, the legacy backing store and the new JDBC
backing store. However after migration, you'll have one backing store. Use of two backing stores is
limited to migration procedures.

If you plan to make any schema changes, make them after the backing store data is migrated
successfully, following directions in TIBCO BusinessEvents Developer’s Guide.

For all versions, first back up your backing store data.

3.0.0 Only Upgrade to 3.x and Update the Legacy Backing Store Schema
New TIBCO BusinessEvents metadata tables were added to the backing store schema in version 3.0.1. If
you are upgrading from version 3.0.0, you first must upgrade to the latest 3.x version before you
migrate data to a JDBC backing store.

Procedure

1. Upgrade from 3.0.0 to the latest 3.x version.

2. If the deployed application is running, gracefully shut down all agents and cache servers before you
proceed.

3. Log in to the Oracle server as be_user, password be_user (or whatever username and password
you are using, as set in the initialize_database.sql script).
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4. Navigate to the location of the scripts (by default in BE_HOME/bin) and open an SQLPlus prompt.
Identify yourself as the user you logged in as.

5. At the SQL prompt, type the following to run the script:

@create_tables.sql

Result

Running this script does not affect any existing tables (therefore there is no need to run be-
oradeploy.exe). Your database tables are now configured.

3.x Only: Import Projects into TIBCO BusinessEvents Studio

Import the project into TIBCO BusinessEvents Studio and ensure that the migrated project is configured
correctly. See Migration of 3.x Projects for full details.

Add a JDBC Backing Store
In this task, you set up a new backing store, including creation of a new JDBC Connection resource.

Do not remove the JDBC Connection resource for the Oracle-only backing store database from your
project until you have completed all migration tasks.

Procedure

1. Add the JDBC backing store, following instructions in Chapter 30, JDBC Backing Store Setup, which
is in TIBCO BusinessEvents Developer’s Guide.

2. It is a good idea to open your project again in TIBCO BusinessEvents Studio and test both the JDBC
connections. If you need to make corrections to the connections, do so before you build the EAR.

3. When you have set up the new backing store, including the JDBC connection and CDD settings,
Rebuild the EAR file.

Set Up the TIBCO BusinessEvents TRA File

Procedure

1. Open the BE_HOME/bin/be-migration.tra file and specify appropriate values for the properties
shown below, with example values.

2. For notes on the properties see Backing Store Data Migration Property Reference.
# Oracle/JDBC Migration Properties
be.migration.batchsize 1000
be.migration.workersize 16
be.migration.objecttable true
be.migration.target.type jdbc
# Database URLs
# Source database:
be.oracle.dburi.count 1
be.oracle.dburi.0 /Resources/myORCL.sharedjdbc
be.oracle.dburi.pool.initial.0 5
be.oracle.dburi.pool.min.0 5
be.oracle.dburi.pool.max.0 10
# Target database:
be.jdbc.dburi.count 1
be.jdbc.dburi.0 /Resources/myJDBC.sharedjdbc
be.jdbc.dburi.pool.initial.0 5
be.jdbc.dburi.pool.min.0 5
be.jdbc.dburi.pool.max.0 10
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Run the Data Migration Process

Procedure

1. Open a command prompt, navigate to BE_HOME/bin, and execute the following command:
   be-migration -copy -ear EARFile

Wait until the process is complete

2. If you set the property be.migration.objecttable=false in Set Up the TIBCO BusinessEvents
TRA File then you must manually migrate OBJECTTABLE table contents. (Use your DBMS product
documentation for this task.)

3. You can now start the TIBCO BusinessEvents engine and use the JDBC backing store with the
migrated data.

Remove Legacy Backing Store and JDBC Connection
When you have tested the migration and are sure that all is working well, you can remove the legacy
backing store JDBC connection and archive, or otherwise remove, the legacy backing store files.

Backing Store Data Migration Property Reference

Oracle-Only to JDBC Backing Store Data Migration

Property Notes

be.migration.batchsize

Defines the database batch size to be used during the migration process. The best
size depends on the database configuration.

Default is: 200

be.migration.workersize

Defines how many concurrent threads to use during the migration process. Set to
the number of processors available.

Default is: 10

be.migration.objecttable

If the existing Oracle backing store contains a large amount of data, the migration
process can take many hours to complete. If this is the case, you can shorten the
process using this property.

When this property is set to false, the migration process ignores the data contained
in OBJECTTABLE table. Skipping this table can shorten the migration time
considerably.

If you skip migration of the OBJECTTABLE table, you must then copy this table from
the Oracle to the JDBC backing store database using other tools (or simple SQL
scripts).

Default is true.

be.migration.target.type
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Property Notes

Defines which type of schema to use for the new backing store. Values are:

jdbc
: The JDBC backing store schema. Use this value for migrating from an Oracle
backing store to a JDBC backing store (the procedure documented in this section).

oracle
: No longer valid as an option.

Default is jdbc.
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Property Migration

This chapter contains a reference table to assist you in locating the 4.x properties or UI settings that
correspond to 3.x properties.

Note that many logging properties have been replaced and are not directly migrated.

The main properties used in prior releases are listed on the left, with their current version equivalents
on the right. Note that it may be possible for properties listed as going in Cluster tab > Properties to be
added to a lower-level property sheet, generally the processing unit property sheet, as appropriate. See
TIBCO BusinessEvents Configuration Guide for more details on configuring the Cluster Definition
Descriptor (CDD) file.

Deprecated and Unused Properties
 Properties that are deprecated in this release or are not used in this release are noted below. A list of
unused properties from older supported versions of TIBCO BusinessEvents is provided in Deprecated
and Unused Properties.

Property Migration Reference

Property Migration Reference

Earlier Version Property (mostly 3.x and 4.x) 5.6 CDD Editor

Agent Group Name (in BAR resource) Agent Classes Tab > AgentClassName >
Agent Class Name

Agent.AgentGroupName.cacheOpsQueueSize Agent Classes Tab > AgentClassName >
Properties

Agent.AgentGroupName.checkDuplicates Agent Classes Tab > AgentClassName >
Check for Duplicates

Agent.AgentGroupName.concurrentwm Agent Classes Tab > AgentClassName >
Concurrent RTC

Agent.AgentGroupName.dbOpsBatchSize Agent Classes Tab > AgentClassName > 
Properties

Agent.AgentGroupName.dbOpsQueueSize Agent Classes Tab > AgentClassName >
Properties

Agent.AgentGroupName.dbthreadcount Agent Classes Tab > AgentClassName > 
Properties

Agent.AgentGroupName.key Processing Units Tab > PUName > Agents >
Key

Agent.AgentGroupName.maxActive Agent Classes Tab > AgentClassName > Max
Active

Agent.AgentGroupName.priority Processing Units Tab > PUName > Agents
table > Priority
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Earlier Version Property (mostly 3.x and 4.x) 5.6 CDD Editor

Agent.AgentGroupName.recoveryPageSize Agent Classes Tab > AgentClassName >
Properties

Agent.AgentGroupName.threadcount Agent Classes Tab > AgentClassName >
Properties

Agent.AgentGroupName.l1CacheSize
be.agent.query.localcache.maxelements

Agent Classes Tab > AgentClassName > Max
Size

be.oracle.dburi.0 (No longer used)
be.jdbc.dburi.0

Cluster Tab > [OM Type - Cache] > Backing
Store > Connection > URI

be.agent.cache.specialom Agent Classes Tab > Cache Agent > Properties

be.agent.cache.specialom.maxthreads Agent Classes Tab > Cache Agent > Properties

be.agent.query.localcache.evictseconds Agent Classes Tab > AgentClassName >
Eviction Time

be.agent.query.localcache.prefetchaggressi
ve

Agent Classes Tab > QueryAgentClassName
Properties

be.backingstore.dburi.pool.initial.0 Cluster Tab > Backing Store > Connection >
Initial Size

be.backingstore.dburi.pool.inactivityTimeo
ut.0

(Applicable only if Oracle strategy is selected)

Cluster Tab > Properties

(Backing store properties)

be.backingstore.dburi.pool.waitTimeout.0

(Applicable only if Oracle strategy is selected)
Cluster Tab > Properties

(Backing store properties)

be.jdbc.readtimeout (No longer used)
be.backingstore.readtimeout

(Applicable only if Oracle strategy is selected)

Cluster Tab > Properties

be.oracle.dburi.pool.enforce.0 (No longer
used)
be.jdbc.dburi.pool.enforce.0

Cluster Tab > [OM Type - Cache] > Backing
Store > Enforce Pools

be.oracle.dburi.pool.initial.0 (No longer
used)
be.jdbc.dburi.pool.initial.0

Cluster Tab > [OM Type - Cache] > Backing
Store > Connection > Initial Size

be.oracle.dburi.pool.max.0 (No longer used)
be.jdbc.dburi.pool.max.0

Cluster Tab > [OM Type - Cache] > Backing
Store > Connection > Max Size

be.oracle.dburi.pool.min.0 (No longer used)
be.jdbc.dburi.pool.min.0

Cluster Tab > [OM Type - Cache] > Backing
Store > Connection > Min Size
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Earlier Version Property (mostly 3.x and 4.x) 5.6 CDD Editor

be.channel.tibjms.queue.disabled Agent Classes Tab > AgentClassName >
Properties

be.channel.tibjms.topic.disabled Agent Classes Tab > AgentClassName >
Properties

be.dbconcepts.connection.check.interval Cluster Tab > Database Concepts > Check
Interval

be.dbconcepts.connection.retry.count Cluster Tab > Database Concepts > Retry
Count

be.dbconcepts.dburi Cluster Tab > Database Concepts > Database
URIs

be.dbconcepts.pool.inactivityTimeout Cluster Tab > Database Concepts > Inactivity
Timeout

be.dbconcepts.pool.initial Cluster Tab > Database Concepts > Initial Size

be.dbconcepts.pool.max Cluster Tab > Database Concepts > Max Size

be.dbconcepts.pool.min Cluster Tab > Database Concepts > Min Size

be.dbconcepts.pool.PropertyCheckInterval Cluster Tab > Database Concepts > Property
Check Interval

be.dbconcepts.pool.waitTimeout Cluster Tab > Database Concepts > Wait
Timeout

be.engine.cacheServer Deprecated

Agent Classes Tab > Agent class type: Cache

be.engine.cacheServer.channel.disable Processing Units Tab > PUname > Properties

Not used

be.engine.cluster.cleanup Cluster Tab > Properties (backing store
related)

be.engine.limited.cache.back.size.limit Cluster Tab > Object Management (Cache) >
Entity Cache Size

be.engine.limited.objectTable.back.size.li
mit

Cluster Tab > Object Management (Cache) >
Object Table Cache Size

be.engine.cluster.isCacheLimited Cluster Tab > Domain Objects > Default > Is
Cache Limited

Cluster Tab > Domain Objects > Overrides >
Entity URI > Is Cache Limited

56

TIBCO BusinessEvents® Installation



Earlier Version Property (mostly 3.x and 4.x) 5.6 CDD Editor

be.engine.cluster.EntityClassName.preload Cluster Tab > Domain Objects > Overrides >
URI > Preload Entities

be.engine.cluster.EntityClassName.preload.
fetchsize

Cluster Tab > Domain Objects > Overrides >
URI > Preload Fetch Size

be.engine.cluster.externalClasses.classLoa
der

Agent Classes Tab> Inference Agent >
Properties

For TIBCO BusinessEvents Decision Manager

be.engine.cluster.externalClasses.path Agent Classes Tab > Inference Agent >
Properties

For TIBCO BusinessEvents Decision Manager

be.engine.cluster.hasBackingStore Cluster Tab > [OM Type - Cache] > Backing
Store > Persistence Option - Shared All
[Oracle/SQL Server/Berkeley DB] or Shared
Nothing

be.engine.cluster.isCacheAside Cluster Tab > [OM Type - Cache] > Backing
Store > Cache Aside

be.engine.cluster.isCacheLimited Cluster Tab > Properties

Limited cache is used by default if backing
store is enabled.

Related setting: Entity metadata > Is Cache
Limited

be.engine.cluster.isObjectCacheFullyLoaded Cluster Tab > Properties

be.engine.cluster.minCacheServers Cluster Tab > [OM Type - Cache] > Cache
Agent Quorum

be.engine.cluster.multiEngineOn Deprecated

Processing Unit > Properties

True by default.

be.engine.cluster.multisite Not used

be.engine.cluster.persistenceProvider Used in version 5.0.1. Replaced by Cluster
Tab > Backing Store. Persistence Option
Shared All, Databasy Type Berkeley DB

be.persistenceprovider.bdb.directory Used in version 5.0.1. Replaced by Cluster
Tab > Backing Store > Shared All > Berkeley
DB

be.engine.cluster.preload Not used. UI supersedes need for this
property. See other Preload properties.
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Earlier Version Property (mostly 3.x and 4.x) 5.6 CDD Editor

be.engine.cluster.EntityClassName.preload
be.engine.cluster.preload.handles
be.engine.cluster.preload.fetchSize

Due to redesign, the properties do not all
map exactly to the current UI. Entity
metadata properties were also used to define
preloading behavior. They are no longer
used.

Cluster Tab > [OM Type - Cache] > Domain
Objects (Default and override settings):
Preload Entities, Preload Handles, Preload
Fetch Size.

be.engine.cluster.smtimeout.pollInterval Cluster Tab > Properties

be.engine.cluster.smtimeout.refreshAhead Cluster Tab > Properties

be.engine.cluster.recovery.distributed No longer used. Recovery is always
distributed.

be.engine.externalClasses.packageExclusion
s

No longer needed. TIBCO BusinessEvents
Decision Manager

property.

be.engine.coherence.useAutomatedRecovery Cluster Tab > Properties

be.engine.hotDeploy.enabled Processing Unit > Hot Deploy

be.engine.kernel.unifiedExtIdMap Agent Classes Tab > Inference Agent >
Properties

be.engine.name (in be-engine.tra file)

be.engine.om.berkeleydb.cacheweight.agent Not supported

be.engine.om.berkeleydb.dbenv Not supported

be.engine.om.berkeleydb.internalcacheperce
nt

Not supported

be.engine.om.eventcache.defaultmaxsize Not supported

be.engine.om.eventcache.maxsize.agent Agent Classes Tab > Inference Agent >
Properties

be.engine.profile.delimiter Cluster Tab > Properties

be.engine.tangosol.oracle.prefetch (No
longer used)

Cluster Tab > Domain Objects > Default >
Preload Fetch Size

be.ft.cluster.name Deprecated

be.ft.enabled Deprecated
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Earlier Version Property (mostly 3.x and 4.x) 5.6 CDD Editor

be.ft.failback.waitmilliseconds Deprecated

be.ft.failover.waitmilliseconds Deprecated

be.ft.nodename Deprecated

be.ft.priority Deprecated

be.hawk.microagent.name Agent Classes Tab > Agent Class > Properties

be.http.compression HTTP channel resource > Advanced Tab >
Compression

be.http.dnsLookups HTTP channel resource > Advanced Tab >
Enable DNS Lookups

be.http.docPage HTTP channel resource > Advanced Tab >
Document Page

For TIBCO BusinessEvents Views:
be.agent.dashboard.http.docpage

be.http.docRoot HTTP channel resource > Advanced tab >
Document Root

For TIBCO BusinessEvents Views:
be.agent.dashboard.http.docroot

be.http.maxKeepAliveRequests HTTP channel resource > Advanced Tab >
Max KeepAlive Requests

be.http.maxProcessors Processing Units Tab > AgentClassName >
Http Properties > Max Processors

be.http.maxHttpHeaderSize HTTP channel resource > Advanced Tab >
Max HTTP Header Size

be.http.maxPostSize HTTP channel resource > Advanced Tab >
Max HTTP Post Size

be.http.maxSavePostSize HTTP channel resource > Advanced Tab >
Max HTTP Save Post Size

be.http.maxSpareThreads HTTP channel resource > Advanced Tab >
Max Spare Threads

be.http.minSpareThreads HTTP channel resource > Advanced Tab >
Min Spare Threads

be.http.compressableMimeType HTTP channel resource > Advanced Tab >
Compressible Mime Types
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Earlier Version Property (mostly 3.x and 4.x) 5.6 CDD Editor

be.http.restrictedUserAgents HTTP channel resource > Advanced Tab >
Restricted User Agents

be.http.useBodyEncodingForURI HTTP channel resource > Advanced Tab >
Use Body Encoding for URI

be.jdbc.cacheLoaderClass
com.tibco.be.jdbcstore.BECoherenceJdbcStor
e
com.tibco.be.oracle.BECoherenceOracleStore

No longer used.

Class loader is implicitly selected depending
on other backing store configuration choices.

be.jdbc.database.type Cluster Tab > [OM Type - Cache] > Backing
Store >

be.jdbc.dburi.strategy.0 Cluster Tab > [OM Type - Cache] > Backing
Store > Strategy

be.jdbc.readtimeout (No longer used) Cluster Tab > Properties

(Backing store properties. Note: replaced by
be.backingstore.readtimeout — see in
this table.)

be.jms.reconnect.msgCodes Agent Classes Tab > Inference Agent >
Properties

be.jms.reconnect.timeout Agent Classes Tab > AgentClassName >
Properties

be.locale.country Not used.

be.locale.language Not used.

be.locale.variant Not used.

be.network.mode.standalone (For query agents) No longer used. See
TIBCO BusinessEvents Query Developer’s
Guide for new configuration.

be.oracle.commitSize Cluster Tab > Properties

See be.backingstore.commitSize

be.oracle.dburi.active.0 Not used.

be.oracle.dburi.pool.inactivityTimeout.0 No longer used.

See be.backingstore.
dburi.pool.inactivityTimeout.0
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Earlier Version Property (mostly 3.x and 4.x) 5.6 CDD Editor

be.oracle.dburi.pool.waitTimeout.0 No longer used.

See be.backingstore.
dburi.pool.waitTimeout.0

be.oracle.debug No longer used.

be.trace.layout.class.arg Collections > Log Configuration >
configname > Custom Line Layout >
Arguments

be.trace.layout.class.name Collections > Log Configuration >
configname > Custom Line Layout > Class

be.trace.log.append Collections Tab > Log Configurations> Files
section > Append

be.trace.log.enable Collections Tab > Log Configurations> Files
section > Enable

be.trace.log.fileName Collections Tab > Log Configurations > Files
section > Name

be.trace.roles Collections Tab > Log Configurations > Roles

The format has also changed. See TIBCO
BusinessEvents Developer’s Guide for details.

be.trace.term.enable Collections Tab > Log Configurations > Send
to Terminal section > Enable

be.trace.log.maxnum

Note
TIBCO BusinessEvents 3.x used this property and
not engine.Log.MaxNum.

Collections Tab > Log Configurations > Files
section > Max number

be.trace.log.maxsize

Note
TIBCO BusinessEvents 3.x used this property and
not engine.Log.MaxSize.

Collections Tab > Log Configurations > Max
size

Agent.AgentGroupName.cacheTxn.updateCache Agent Classes Tab > AgentClassName >
Properties

Checkpoint Interval (in BAR resource) Cluster Tab [OM Type - Berkeley DB] >
Checkpoint Interval

com.tibco.cep.runtime.channel.payload.vali
dation

Cluster Tab > Properties (May be more likely
at agent class level)
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Earlier Version Property (mostly 3.x and 4.x) 5.6 CDD Editor

com.tibco.cep.runtime.scheduler.default.nu
mThreads

Agent Tab > Shared Queue > Thread Count

com.tibco.cep.runtime.scheduler.queueSize Agent Tab > Shared Queue > Queue Size

com.tibco.tibjms.connect.attempts Agent Classes Tab > AgentClassName >
Properties

com.tibco.tibjms.naming.security_protocol Agent Classes Tab > Inference Agent >
Properties

Database Environment Directory (in BAR 
resource)

Cluster Tab [OM Type - Berkeley DB] >
Database Environment Directory

Delete Retracted Objects from Database (in BAR
resource)

Cluster Tab [OM Type - Berkeley DB] > Delete
Retracted Objects from Database

Do not Recover on Restart (in BAR 
resource)

Cluster Tab [OM Type - Berkeley DB] > Do
Not Recover on Restart

Engine.FT.ActivationDelay Deprecated

Engine.FT.ActivationInterval Deprecated

Engine.FT.GroupName Deprecated

Engine.FT.HeartbeatInterval Deprecated

Engine.FT.UseFT Deprecated

Engine.FT.Weight Deprecated

Engine.Log.Dir Collections Tab > Log Configurations

Hawk.AMI.DisplayName Agent Classes Tab > Agent Class > Properties

java.net.preferIPv4Stack Cluster Tab > Properties

objectTable.back.size.limit Cluster Tab > Properties

Property Cache Size (in BAR resource) Cluster Tab [OM Type - Berkeley DB] >
Property Cache Size

Schedule a checkpoint if outstanding DB 
ops greater than (in BAR resource)

Cluster Tab [OM Type - Berkeley DB] >
Checkpoint Ops Limit

tangosol.coherence.cacheconfig No longer used. Autoassigned.

tangosol.coherence.cluster Cluster Tab > General > Cluster Name
(Also used for TIBCO BusinessEvents
DataGrid cache provider cluster name)
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Earlier Version Property (mostly 3.x and 4.x) 5.6 CDD Editor

tangosol.coherence.clusteraddress Cluster Tab > Properties

tangosol.coherence.clusterport Cluster Tab > Properties.

tangosol.coherence.distributed.backupcount Cluster Tab > Object Management (Cache) >
Number of Backup Copies

tangosol.coherence.distributed.localstorag
e

(In 5.0, also used for TIBCO BusinessEvents
DataGrid property be.engine.cluster.isSeeder)

Process Units Tab > Enable Cache Storage

tangosol.coherence.distributed.threads Cluster Tab > Properties

tangosol.coherence.localhost Cluster Tab > Properties

tangosol.coherence.localport Cluster Tab > Properties

tangosol.coherence.log Processing Units Tab > PUName > Properties

tangosol.coherence.log.level Processing Units Tab > PUName > Properties

tangosol.coherence.log.limit Processing Units Tab > PUName > Properties

tangosol.coherence.ttl Cluster Tab > Properties

tangosol.coherence.wkan Cluster Tab > Properties

tangosol.coherence.wkan.port Cluster Tab > Properties

tibco.be.property.datatype.null.value Cluster Tab > Properties

Used for special handling of null properties
and values.

tibco.bwengine.name Processing Units Tab > PUName > Properties

tibco.clientVar.<GlobalVariable> Cluster/PU/Agent level properties
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Deprecated and Unused Properties

The following TIBCO BusinessEvents engine properties were deprecated or made obsolete (not used) in
an earlier release of TIBCO BusinessEvents. Properties newly deprecated or not used in the current
release are noted in Property Migration.

Deprecated and Unused Engine Properties

Property Description

be.engine.cluster.externalClasses.packageexclusions

Obsolete property. Used to exclude non-decision table classes when working with
generated class files. Now only decision table classes are generated. Removed in
version 5.1.0.

be.engine.cluster.cacheType

Deprecated property. Ignored if present. In 3.0.0, this property specifies which of
the following provided caching schemes to use: dist-unlimited-bs, dist-
limited-bs, or dist-unlimited-nobs (default)

be.engine.cluster.cacheType

Deprecated property. Ignored if present. In 3.0.0, this property specifies which of
the following provided caching schemes to use: dist-unlimited-bs, dist-
limited-bs, or dist-unlimited-nobs (default)

be.engine.om.recovery.threads

Not used in this release. Ignored if present.

be.ft.cluster.name

Deprecated property.

be.ft.enabled

Deprecated property.

be.ft.failback.waitmilliseconds
be.ft.failover.waitmilliseconds

Deprecated Properties. These properties were introduced in a 2.x release to define a
wait period, ensuring that cache was fully initialized before failing over to a
secondary or failing back to the recovered primary.

be.ft.node.name

Deprecated property.

be.ft.priority
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Property Description

Deprecated property.

be.locale.country

Sets the country code to use for localization. Use upper case. Uses the ISO 3166
standard.

Note
: TIBCO BusinessEvents is not fully localized in this release.

be.locale.language

Sets the language code to use for localization. Uses the ISO 639 standard.

Note
: TIBCO BusinessEvents is not fully localized in this release.

be.locale.variant

Optional extension to the locale language, for example, if you set
be.locale.language to en, you might set be.locale.variant to US, which is
interpreted as en_US

Note
: TIBCO BusinessEvents is not fully localized in this release.

com.tibco.be.jdbcstore.BECoherenceJdbcStore
com.tibco.be.oracle.BECoherenceOracleStore

The above properties specified the cache loader class for backing stores. Later there
was a Cache Loader Class setting, removed in 5.0. Now the cache loader class value
is set internally.

be.trace.publish.enable
be.trace.publish.subject
be.trace.publish.daemon
be.trace.publish.network
be.trace.publish.service

Deprecated properties. The above properties are ignored by the engine. Instead use
current settings in the CDD. See the TIBCO BusinessEvents Cluster Deployment
Descriptor Configuration Guide for the current logging properties.

be.trace.log.dir
be.trace.enable

Deprecated properties. The above properties are still used by the engine if found in
the TRA or CDD file. However, do not use these properties. Instead use current
settings in the CDD. See TIBCO BusinessEvents Cluster Deployment Descriptor
Configuration Guide for the current logging settings.
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Property Description

Engine.Log.MaxNum
Engine.Log.MaxSize

These properties are set by TIBCO Administrator during deployment. Do not set
them in your projects.

Engine.FT.UseFT
Engine.FT.Groupname
Engine.FT.Weight

Deprecated properties. Were used for In Memory OM fault tolerance in 3.x. Instead,
configure for Cache OM, but use the Memory Only mode for all objects. See also
be.ft.nodename which was used for the same purpose.

tangosol.coherence.cacheconfig

Not needed except as advised by TIBCO Support for customization purposes.
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